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software 
Thank you for purchasing this software product!
We think you will be delighted with this Windows REAL TIME thermal analysis software package.  We have suc-
ceeded in this 32 BIT product in getting 33 frame per second capture rate - camera to frame grabber - to processing an 
image. 

This software is designed to provide all the needed tools in a easy to use, user friendly software in a familiar Windows 
environment. 

The Manual
About this manual
We have striven for information presented in a consistent manner from chapter to chapter, knowing that a manual is 
read when it is easy to read. 

The TITLE PAGE will indicate the VERSION of the MANUAL to alert the user to dated manuals.

A complete TABLE OF CONTENTS is present at the very beginning of this manual.

The manual presents information by describing the functions of the software menus.  Each chapter of the manual cov-
ers ONLY ONE MENU with all of its functions. 

An index is located at the back of this manual.  Every function in this software can be looked up and located easily 
and quickly.

A manual chapter generally has these items:  
1. An introduction.
2. A listing of chapter contents.
3. Related subjects.
4. Tool Bars.
5. Introduction to the Menu function
6. The functions of the menu..
7. Graphics, screen shots, etc., are used liberally to explain topics.

The software
Some important features of this software:

1. Software organized into modules that have related functions.
2. Real time software thermal image analyst.
3. Temperature tools - POINT, SPOT, LINE, CIRCLE, ELIPSE, RECTANGLE, and SHAPE.
4. Trending with IMAGE SUBTRACTION.
5. Event manager to move data to different kinds of outputs.
6. Palette selections with a palette editor.
7. CAD functions with shapes, color fills. You can even arrange the objects vertically in layers. 
8. CLICK AND DRAG editing that is consistent across the software.
9. Emissivity and temperature region correction from a user created table that is saved for later use.



10. Windows CLIPBOARD support.
11. Template/Report Editor features. 
12. No limits on the numbers, position, and size of images, and graphs placed in a report.
13. Fields place data on the report generator.
14. Powerful graphing module with many different formats that displays REAL TIME and STATIC IMAGES.
15. Isotherms with SPAN and CENTER point adjustable to less than a degree if camera resolution permits.
16. Compatible with Windows NT 4.0. 
17. Network support. 
18. An much more . . .

Learning the software
Is this software hard to learn and use since has so many features.  All menus, functions are direct with at most 2 pull 
down menus. Extensive help files explain every functions with detailed drawings and explanations. This is productiv-
ity software - and the time required to learn the basic software functions is not long.

To get the user started a special booklet - getting started is included with the software. This contains a BRIEF intro-
duction to all the BASIC FEATURES of the software, installing hardware, and installing the software. 

Some of the productivity tools . . 
 

1. Speed Menus, accessed by the Right Mouse Button provide fast access to commonly used work functions.
2. The software installs automatically, creating all the necessary directories, and installing samples. A Program 

Group is created with ICONS for software program, frame grabber selection, and copy protection. 
3. Easy upgrades from a WEBSITE. 
4. Printer drivers supplied by Windows. Print manager. 

This is processing software primarily 
The purpose for which this software is written is INDUSTRIAL PROCESSING:

1. Display live thermal images at 33 frames per second NTSC.
2. Permit thermal analysis of live thermal images in real time.
3. Provide very flexible ways of reporting data in a comprehensive EVENT MANAGER to computer hardware 

such as disk, floppy, Replay Editor, and event management over time.
4. Powerful graphing tools.
5. A standard Image Editor for post image analysis with ZOOM.
6. An enhanced Template and Report generation capability.



Introduction
The purpose of this chapter to provide the software user with a OVERVIEW of SOFTWARE BASICS. To begin 
using this software to its full potentional the user needs to understand th topics in this chapter.  

Software Basics
Topics covered in this chapter

1. Objects
2. Mouse operations
3. The tool bars, and menus
4. The software structure.
5. Preferences
6. Speed Menus
7. The software modules.

Related subjects
Chapter 6 - The Edit Menu

Definition of a Software Objects 
An object is anything placed OVER and IR IMAGE. It is also possible to OVERLAY OBJECTS on a VISIBLE 
IMAGE.  An OBJECT is an overlay on the thermal image. It does not alter the IMAGE in ANY MANNER. Exam-
ples of Objects are:

1. TEMPERATURE OBJECTS Point, Line, Rectangle, Circle, Shape, and Spot 
2. CAD OBJECTS such as rectangles, text, lines, arrows. 
3. FIELDS such as Point, Spot, Rectangle, Line, Circle, and Shape and the utility fields.
4. IR IMAGES - when placed on a report or template.
5. ISOTHERMS.
6. RICH TEXT.

The properties of objects 
Every object that exists in this software is selected and edited in THE SAME MANNER. The exception is an ISO-
THERM which has a control view portion located on the COLOR BAR and the ISOTHERM DISPLAY located on 
the IMAGE. 

Not all objects have the same VIEW properties. The best way of determining this is by SELECTING and then 
RIGHT CLICKING on a mouse button to see what SPEED MENU functions are available. These would be border 
thickness, color, font size, font color, solid color, etc.
Images
IR Images
 IR Images are images produced by an Infrared Camera. They are images of heat (Infrared) emitted by physical 
object. These can be any bit resolutions though they are commonly 8 bits (256 shades of gray) and 12 bits.
Visible Images
Visible images are produced by a camera that takes pictures that are VISIBLE to the EYE.  These can 8 bits through 
24 bits.  



Copying Images
To copy an image to a CLIPBOARD select the WINDOW containing the Image.  ALSO - if the window is being 
used make sure that ALL objects have been deselected.
Selecting an Object

Before ANY EDITING can be done on an object is MUST BE 
SELECED. 
The mouse cursor must be an arrow before it can be used to SELECT. 
To do this press the ESC key or CLICK on the ARROW TOOL. The 
STATUS BAR will then say EDIT. 
How to. . .
Place the tip of the mouse ARROW cursor ANYWHERE on the object 
and CLICK the LEFT MOUSE BUTTON. As shown in the illustration 

on the LEFT if an object is selected the rectangles or handles will appear. In this case they are WHITE. For more 
information on handles see the next section.

Some differences in objects -
Objects differ - so that a filled object can be selected by CLICKING anywhere on that object..   
A temperature object can be selected ONLY by CLICKING on the object NOT the text of the label. 
Multiple temperature object selection 
A special case exists for this type of selection, which is used to select more than one temperature object for graphing.  
HOLD DOWN THE CTRL KEY and CLICK the LEFT MOUSE BUTTON on a temperature object.This applies to 
LINE in the Image Editor or LINE, SPOT, and POINT in the Frame Grabber Module
Editing an object 
RESIZE OBJECTS
To resize an object  place the mouse cursor on any of the handles (white rectangles) CLICK the LEFT MOUSE BUT-
TON and while holding down the mouse button move the mouse to resize and reposition. If an object is SOLID it 
becomes transparent with a dotted outline so that the user can see underneath the object for easier repositioning. To 
lock the edit results release the mouse button. If the object is not solid the border becomes a dotted outline. Note: in 
the TEMPLATE EDITOR the DOTTED OUTLINE is SOLID. 
POSITIONING OBJECTS
To place an object in a different position on the image CLICK the LEFT MOUSE button anywhere on the object, and 
while holding down the mouse button move the mouse.  Remember the rules for solid and not filled objects - if an 
object is filled the user can CLICK anywhere - if an object is not filled CLICK ONLY on the border. To lock the edit 
results release the mouse button.
DUPLICATION
Any Selected objects can be duplicated by pressing Ctrl D in the REPORT EDITOR.
CUT and PASTE
Any selected objected can similarly be cut and pasted by using Ctrl Insert to COPY, and Ctrl Shift to paste. Or the 
functions available in the EDIT MENU can be used.
Mouse Operations
The mouse is required to use the software.  It performs all the CAD functions of the software such as positioning, 
resizing of objects, the placing of objects, drawing shapes etc. A two button mouse is required for the software.
LEFT BUTTON CLICK
Used for selecting objects, and menu items.
RIGHT BUTTON CLICK 
Used to display a SPEED MENU.  A speed menu will display where the MOUSE CURSOR is LOCATED by a 



RIGHT CLICK of the Mouse Button.  There are many different speed menus - the one displayed depends on the 
object selected or the software MODE.
DRAG
Used to move or resize and object.  Select the object first.  Then CLICK the LEFT MOUSE BUTTON on Handles, or 
anywhere on the object and hold down.  Then move the mouse to position or resize.
CTRL + LEFT MOUSE BUTTON
Use to select items on a file list. While holding down the CTRL key CLICK the LEFT MOUSE BUTTON on the file 
items. This is useful if multiple image files for loading in the software are wanted.
SHIFT + LEFT MOUSE BUTTON
Use to select items on a file list. While holding down the CTRL key CLICK the LEFT MOUSE BUTTON on the file 
items. This is useful if multiple image files for loading in the software are wanted.
DOUBLE LEFT MOUSE BUTTON CLICK
Use to select text edit mode in a TEXT OBJECT used in the Report Editor ONLY.  Place the MOUSE CURSOR on 
the Text Object and DOUBLE CLICK the LEFT BUTTON. A text entry cursor indicated by a RAIL CURSOR is 
placed at the beginning of the first text line.
Mouse Cursors
The function indicated by the cursor is AVAILABLE when the MOUSE CHANGES into that cursor. 

Zoom 
Click on View in the Image Editor. The mouse cursor then changes into a magnifying glass with a + 
inside it. Use this by placing the cursor on the image and dragging a rectangle around the area to ZOOM. 

Paint Brush
Used in the Report Editor.  CLICK on Format and CLICK on Paint Brush.  Use by CLICKING the Paint 
Brush on an TEXT or FIELD object that is to be copied and then CLICKING on the object that is to be 
changed.

Edit Mouse Cursor
Press the computer Esc key, or CLICK on the ARROW in the TEMPERATURE TOOL BAR to display 
this cursor..

Temperature Object
CLICK on a temperature object such as Point, Shape, Spot, etc., and then use the cursor to place the 
mouse exactly where the temperature is to be read or where the temperature object is to be placed.

Rail Cursor
Appears when TEXT is selected and operating.  Allows entry of text and editing of text.



Tool Bars 

Introduction
A tool bar is a set of one or more tools.   They provided a convenient way of  accessing software functions by LEFT 
CLICKING the MOUSE on a TOOL. Note that the middle one is depressed, meaning that it is selected.

TOOL TIPS - if  the user RESTS a MOUSE CURSOR on the tool an explanation of the tool is provided in a POP UP 
RECTANGLE. 

The tool bar can be DOCKED or  POSITIONED and RESHAPED as the user desires.

DOCKED TOOL BARS
A DOCKED tool bar is located against one of the sides of the SOFTWARE WINDOW.  To move the TOOL BAR 
CLICK the MOUSE on the  vertical bar on the LEFT SIDE of the TOOL and  DRAG the TOOL BAR to a new posi-
tion. The example above is a DOCKED TOOL BAR. 

UNDOCKED TOOL BARS
Reshape an  UNDOCKED TOOL by placing the  mouse cursor on 
a corner so that the mouse cursor becomes an UP/DOWN arrow. 
While holding down the LEFT MOUSE button drag the TOOL 
BAR to a new shape. The tools on the tool bar can also be custom-
ized.

CUSTOMIZING TOOL BARS
The software is provided  with  tool bars that can be customized 
by  adding or removing tools.  Do this by RIGHT CLICKING  
anywhere on a TOOL BAR. 

Each module of the software - Frame grabber, Image Editor, 
Graph, and Report Editor can have its own customized set of tool 
bars.  This provides the user with exactly the TOOLS needed.  

Customizing the software with preferences
Preferences allows the user to change how the software operates  
to suit individual taste. There are also a few MODE preferences 
that make the software operate in fundamentally different ways. 

Note - preferences with a few noted exceptions set DEFAULTS. Tools and Speed Menu items apply only to the 
SELECTED OBJECT and NEVER SET DEFAULTS.
How to access preferences . . .
CLICK on FILE and then CLICK on preferences.  CLICK on the particular TAB as listed in this section to make the 
required changes.
PREFERENCE Image Tab
Image tab applies to the Frame Grabber and Image Editor Modules.
Image Tab settings



Image Display ASPECT RATIO
Aspect ratio maintains the correct height to width of an image when 
its size is altered with ZOOM, or Windows RESIZE.
Zoom to 
New Window - ZOOM creates a new WINDOW 
in which to place the zoomed portion of the image.
Original Window - ZOOM uses the original Window to display the 
zoom portion of the image, with a new heading. Degrees Set the 
temperature scale to use with all temperature related objects.  
Default Palette
Set a palette that the software will use when displaying an image
Default Labels
Set a label to use with all TEMPERATURE OBJECTS.
 
PREFERENCE Annotations Tab
This tab applies to the Frame Grabber, and Image Editor.
Changes to this TAB do not apply to objects in existence. It does 
apply ONLY to new objects. 
Change Font
Applies the selected font to ANY NEW text.  
Set Line thickness 
Set a line thickness for any NEW line, border, temperature annota-
tion, etc.
Change Annotation Color
A color selected with this control applies to any NEW annotations 
(objects). 
PREFERENCE Mini Graph Tab 
This tab applies to Frame Grabber and Image Editor.
Changes to this TAB apply to objects in existence. It does NOT 
apply ONLY to new objects.

See the illustration immediately below to understand the terminol-
ogy and to what it applies on a mini-graph. 
Select Color 
The effect of the different options on a MINI GRAPH are shown to 
the right. 
Background - apply selected background color to a temperature 
MINI-GRAPH.  Apply Background needs to be checked for this to 
apply.
Labels - apply selected color to the text of a temperature object with 
a MINI-GRAPH.
Border - apply selected color to the border of a temperature object 
with a MINI-GRAPH.
Data - apply selected color to the graph representation of the mini-
graph temperature object. 
Mini Graph Options
Show Graph Always - display by DEFAULT graphical representa-
tion of the temperature. 



Show Histogram Always - display by DEFAULT a histo-
gram representation.
Apply Background - by DEFAULT always display a back-
ground to a MINI-GRAPH. 

PREFERENCE Editor Tab
This tab applies ONLY to the Report Editor. Changes made 
using the tools in the Report Editor only change the text being 
applied.
Page Size - 
Change the page size of REPORT.
Margins - 
Change the margins of a report.
Defaults -
CLICK on Defaults to RESTORE changes to page size and 
margins to a default or the values shown in the illustration to 
the right. 
Snap to Grid
Snap Objects to Grid.  Enable a snap (auto placement)  of 
objects, when dragged to GRID. 
Show Grid.   Display a series of dots on a template. These 
dots make up a grid for alignment of objects.
Grid Spacing 
Set the width and height spacing of the grid. The default set-
ting of .1 inches is a good setting. 
Reporter Mode
While making a report the software can use a special fill in 
mode. Text that is changed or filled in can be set to a color to 
aide placement of text while making reports.  IT DOES NOT 
PRINT THESE FILL IN COLORS. 
Set Standard Mode.  
CLICK to not use FILL IN MODE. This mode also enables 
the report editor to bypass template making as a first step and 
allow the user to make a report from a BLANK SHEET com-
pletely. This trades that flexibility for a more difficult and 
time consuming report making process.
Reporter White Background.  
Set the software to use a fill in MODE. Default is white back-
ground with CYAN fill in box.  Use the COLOR CONTROL 
shown to the right to set background color.  Background color 
is the color of the text box on which the user places the text.  
Foreground is the color of the text.
Report Black Blackground.  
Set the software to use a fill in MODE. Default is BLACK 
background with RED BACKGROUND on FILL IN BOX.  
Use the COLOR CONTROL shown to the right to set back-
ground color.  Background color is the color of the text box 
on which the user places the text.  Foreground is the color of 
the text.



PREFERENCE Graph Settings Tab
Enter the default graph settings to applied to any graph accessed in the provided text box.
PREFERENCE Setup Tab
This tab applies to Frame Grabber, Image Editor, and Report Editor. Exception is Mouse Temperatures.
Status Bar  
Check this item to place a status bar on the software windows. The status line has information useful to operation of 
the software. 
Mouse Temperature
Check this item to place temperature under the mouse. This temperature is read on the right hand side of the status 
bar.
Image Editor Precision
This applies ONLY to the Image Editor. Set the number of decimal places for temperature resolution from 0 to 2.  
This effects every temperature object used in the Image Editor. 
Instant Save
Instant save is a way of saving a series of WORK IMAGES from the Image Editor. These files 
ALL have the same name but are auto incremented with a number. This is a way of not over writ-
ing previous versions of the software. 

A path must be setup for the tool in the Standard Toolbar to become active.  

Path.  Set up a path for or location where files are saved. LONG FILE 
NAMES can be used. 
File Type. Click on the down arrow in File Type to select from the 
types of images as shown to the right. 
File Counter.  Enter the auto increment number.  For example set the 
number to 100. And the file name to ’my image. bmp’.  Then each 
image would be ’my image 100.bmp, my image 101.bmp, etc.

PREFERENCE Editor Text Object
This applies ONLY to TEXT OBJECT in the Template Editor.  
To access this control go to Template by CLICKING on Report 
and then CLICKING on CREATE A TEMPLATE. Then CLICK 
on Text Object. Alternatively CLICK on the ABC tool. 

If an object is up or being used, changes to this dialog will not be 
applied until a new TEXT OBJECT is placed in a template.
Change Font
CLICK on Font to access the Font Select Dialog and Select a 
Font, and font attributes.
Change Background Color
Select a background color for a text object.
NOTE: this is a different attribute than those selected under the 
Editor Tab in the Reporter Modes.  These are AIDES, and do not 
print. The background color selected in this TAB DOES PRINT.
MUCH COMFUSION can result if the Reporter Mode has the 
same colors as Background Color and the Font Color. Exercise 
particular care when working with these PREFERENCE 
OPTIONS. 



Change Border Color
Select a border color to be applied to a TEXT OBJECT.  If the user makes back-
ground and border the same color they do not appear. 

Speed Menus
Introduction
Speed menus are POP UP MENUS with defined set of functions.  These functions 
relate to the object selected.  Example - if a temperature object is selected the fol-
lowing speed menu pops up. 

Most selected object will have associated with it a speed menu.  

Since there are a great number of these this manual would become very lengthy if 
each one is described. There is, therefore, no listing of all these numerous speed 
menus.  

NOTE: each of the functions on the speed menu is described in a chapter so that the 
software user needs only to turn to that chapter describing.

Many, but NOT all of the functions on the speed menus are duplicated with a TOOL in a tool bar, or more certainly 
with a MENU. 
How to use . . .
CLICK on the object to select. Then CLICK the RIGHT MOUSE BUTTON to have the associated Speed Menu pop 
up.

To use any of the functions listed on the menu - CLICK with the LEFT MOUSE BUTTON .  After the function is 
used the Speed Menu will be removed automatically. 

The navigating around in the software 
Introduction
This section of the manual will provide the user with a overview of the software, necessary to effectively use the soft-
ware.
A listing of  the modules in the software

1. Image Editor
2. Frame Grabber Module
3. Graphing Module
4. Report Editor

Image Editor
This software module contains the tools for post-image analysis of infrared images. These images can either be 
loaded from a file, or from the frame grabber module. 

From this module the user can save images, print images, colorize images, apply isotherms, or do everything required 
to turn a RAW INFRARED IMAGE into a annotated image.
Frame Grabber
This module works with a installed frame grabber to receive live images at the frame grabber rate.

A full set of analysis tools can be applied to a LIVE IMAGE, such a points, spots, line, shape, and rectangle.  Images 
can be isothermed and colorized.  

This module contains the EVENT MANAGER which enables the analysis of temperature information over time and 



at preset intervals send this data to files, or recorders. 

It also has a snap shot capability so that a series of live images can be recorded and then played back like a VCR at a 
later date. 

Graphing Module
This module will display data in a variety of graph formats in real time, or from an image in the Image Editor.

It is a powerful tool for graphically presenting complex temperature information.

Report Editor
The report editor is the module from which a report can be made from data taken from an image in the Image Editor.

It also contains a template editor that software user can use to make reports with a fixed format.

Using the software with TVS 2000 

The install program takes care of the entire selection process for the proper frame grabber and the selection of the 
camera.  Exercise particular care during install. that you select Flash Bus MV PRO.

WARNING while using the TVS 2000
There are things you cannot do with the TVS 2000 computer (the part of the camera that has the keyboard, screens, 
etc.).

1. The External Interface must be set at 232C, 9600, 8, None, 1, None, None.
2. The image must be in B/W color mode.
3. Autoscaling must be turned off.  It is acceptable to turn it on for a brief period of time to get the correct 

adjustments, but then turn it right off.  But it can NOT remain on.
4. Any part of the image that is excluded using the Selective Graduation Display function can not be calibrated.
5. The framegrabber adjustments must be setup such that there is no saturation of either high or low end.
6. Only the range currently displayed on the camera can be measured, everything above or below the range will 

display as the max or min temperatures of that range.
7. Using the Level button, to change the Display Gradations setting will cause the calibration to become much 

less accurate.  This should be left at 256 gradients.





Introduction to the Events Menu
Events in this software means the ability to cause temperature related data from the temperature tools to be sent to a 
variety of devices - spread sheets, DA convertors, the hard disk. All of this occurs in REAL TIME or as the event 
occurs.  

This chapter is crucial to effective use of the software and will require lots of study and hand on application. 

The Events Menu
Software Location
LIVE WINDOW ONLY. 

The following functions are found in 
the EVENTS MENU  

 1. Setup Events
 2. Acknowledge Alarms
 3. Edit ROI
 4. Movie Save
 5. Set Object Measurement Rates
 6. Log to Excel
 7. Setup Analog Output

Related topics
These should be reviewed when studying any of the 
EVENT MENU CONTROLS.

1. Editing objects chapter 4.
2. Using the mouse chapter 4. 
3. Speed menus chapter 4
4. Preferences chapter 4
5. Edit menu chapter 4
6. GLOSSARY.

Toolbars



The Events Menu Functions
The Events Menu contains a group of functions that setup, time, and controle the management of temperature data.
The following discussion of these functions are not arranged in the same order as the image.  

Edit ROI
ROI stands for REGION OF INTEREST. It is a saved rectangle 
annotated on an image. If it is selected the software will perform a 
selected function on that rectangle. A ROI also saves computer 
resources since an entire image often is not required for analysis or 
other operations. The smaller the given ROI, and still able to per-
form the intented function, always results in a conservation of 
computer resources which makes the software run faster.

A ROI has a spacial relationship to the IMAGE WINDOW ONLY.  
It is NOT fixed or attached to the image.  In this way an image can 
change in real time but the ROI is fixed in the windows position.  
The user can give a descriptive name to a ROI, such as size, loca-
tion on the image, temperature, etc., to aide later recall.  It does not 
save an image associated with the ROI to aide this recall process.
Many of the Event functions will then use a ROI and the user can 
scroll through a list of names to select the one desired. 
 

How to use . . .

ACCESSING ROI. CLICK on Events Menu and CLICK on Edit 
ROI. The control shown to the right is displayed. Type in a long 
file name for the ROI in the EDIT BOX to the LEFT of Create 
Roi,  and then CLICK on Create ROI. 
DRAWING A ROI. The name will be added to any ROI list and saved. The mouse cursor will CHANGE TO A 
PLUS.  Place this + where the upper LEFT CORNER of the ROI is to be located and CLICK the LEFT MOUSE 
AND HOLD DOWN.
CHANGING THE SHAPE OR POSITION OF A ROI. To resize DRAG the rectangle to the desired size and 
shape, as with any editable rectangle. Release the mouse button and the ROI remains editable.  Reposition or resize as 
desired. CLICK Close and the ROI is saved, the Edit ROI control is put away and the ROI BECOMES INVISIBLE.

Editing a ROI - 

Click on the drop down list to display a list of ROIs.  CLICK on a name and the corresponding ROI is displayed in on 
the screen.  It is now an editable object.  All the rules of editing now apply. Select it and resize or drag to a new posi-
tion. The example to right show a SELECTED ROI.  The color of the editable ROI outline is dotted and white, or 
black depending on the background color. 

Remove -  

CLICK on the drop down list to display a list of ROIs and CLICK on a name to select a ROI.  The ROI is displayed.  
CLICK on Remove.



Movie Save 

This function saves a series of frames from a LIVE IMAGE. These are saved to the computer memory and the hard 
drive to be viewed by the Fast Save Replay Tool Bar.  See chapter 8 of this manual for the Replay Toolbar. 

How to use . . .

 CLICK on Events and then CLICK on Movie 
Save. Or CLICK on the Movie Save in the Events 
toolbar shown to the left.  The control shown 
above pops up for use. .
Duration - Select time units Frames, Milliseconds 
(1/1000 of a second) and seconds, and then enter 
amount of time. 
Then ENTER the NUMBER of FRAMES you 
want to save.  This is the DURATION of the 
MOVIE SAVE. 
Ms between Frames - Set the time between 
frames. This is limited by the upper frame rate of the camera.  The lower limit is 99999 ms. 
Select ROI a previously saved ROI.  
The software defaults to full screen, which if this is desired, the user needs do nothing to this control.
See the preceding section in this manual on Edit Roi.
The ROI will show on the image to be movie saved as a dotted line in this case. 
Check Context Frame - Check this box to cause the software to save the entire image in the LAST FRAME as 
BACKGROUND or CONTEXT for the REPLAY series of frames to provide a CONTEXT. This control is active 
ONLY when a ROI is selected. 
Start - begin a Movie Save.
Cancel - Exit if no fast save is desired.
After the amount of time required to save the frames a SPECIAL REPLAY WINDOW will POP UP.  You identify 
this by the the TITLE BAR which says Replay Viewer as shown above. This window may be behind the LIVE WIN-
DOW. This window behaves like a Window and can be selected, mimized, saved, etc. 
Use the Replay Toolbar to view the series of FRAMES saved by using the FAST SAVE.  See Chapter 8 of this manual 

Set CAPTURE in 
Frames or time 

Save last ENTIRE 
image as a 
CONTEXT of the 
frame for the first 
frame. 

Start FAST SAVE 

Number of frames or 
time 

Leave alone for 
default or select a 
previously saved ROI.
See edit ROI.  

Set time in 
milliseconds between 
Frames.  Upper limit 
is the frame rate of 
the camera  

Select a FILE name 
to Save to. 



for a full discussion of this Toolbar.
What is active
NOTE: Selecting the ReplayViewer window will cause the Replay Toolbar to become active (ungrayed). Selecting 
the Live Window will cause Fast Save to become active. Much confusion can result unless this is understood. 

Set Measure-
ment Rate
This function provides 
enables the selection of  
ALL temperature 
objects or a selected 
TYPE of temperaature 
object, such as all Line 
Temperature,  and set 
the measurement inter-
val, or HOW OFTEN 
that temperature object 
TYPE  is accessed.  It 
is also possible to set 
the amount of delay 
before displaying the 
temperature or to 
AVERAGE the tem-
perature for display. 

The settings for a tem-
perature object type 
are stored for reference 
when the control is 
accessed. See the sec-
tion below in “How to use . . .’.

How to use . . .

CLICK on Events and then CLICK on Set Measure Rate  The control shown below is then made available to the soft-
ware user.

Temperature Extract
If the software user wishes to apply the settings in this control to every type of temperature object used in the soft-
ware then CLICK on ALL  

All by default is checked. If it is desired to affect only a selected CLASS of temperature objects then CLICK on ALL 
to remove the CHECKMARK and then CLICK a Radial Button that relates to the temperature CLASS desired.

Common Settings
Measurement Rate --
See the illustration below which explains the relationship of Measurement Rate to Temperature display INTERVAL 

Set the temperature
display INTERVAL

CLICK to apply
to all temperature
objects

Set INTERVAL
for temperature
measurement

Select ONE
TYPE of
temperature
objects.



Set the rate to ms/Frames, Seconds, Minutes, or Hours. Maximum time allowed for each is 99,999. 
This will determine how often the temperature object class will TAKE A MEASUREMENT for display. 
Decimal Digits to Display --
Set the number of digits displayed from 0 to 2. 
Temperature Display Interval --

THIS CONTROL BECOMES ACTIVE ONLY WHEN AVERAGE is CHECKED. 

Display Rate -
If AVG is is NOT CHECKED the temperature is displayed at the time set in the previous section with Measurement 
Interval. 
In the illustration to the 
right, each time Tem-
perature Display inter-
val TIMES OUT, the 
AVERAGE of the 3 
preceeding Measure-
ment Rates. 
This control provides 
ONLY an AVERAGE 
of the Temperature 
Display Intervals.  The 
number of these is 
determined by the 
amount of time set in 
this control. In the 
example below it was 
set to permit the 
AVERAGE of THREE 
INTERVALS.  The 
readings are taken at 
the time each Measure-
ment Rate took place 
and averaged for display at the time set by this control.  In other words the display is ONLY updated at the times 
indicated by the GRAY BARS with the AVERAGE of the temperature values at the time of the BLACK BARS. 

As can be seen the temperature is varying from one value to another. 

How to use -
CLICK on the AVG Check Box, and then CLICK on the DISPLAY RATE radio button - the input boxes to set time 
become available.

Set the rate to ms/Frames, Seconds, Minutes, or Hours. Maximum time allowed for each is 66.  Take care that the set 
time is such that a the  number of Rate Intervals (those shown in BLACK in the illustration) is correct.  For example 
if it is desired to average three Rate Intervals then Rate Interval is set to 33 ms and Temperature Display Interval is set 
to 3 x 33 or 99 ms. 

Number of Samples
How to --

Measurement
Rate. Temperature Display

Interval

Take and average of the
readings at  these
intervals

When this time happens

Temperature

When the temperature
Object is placed.



An alternative method is to enter the number of samples by CLICKING on Number of Samples radio button and then 
typing in the number of frames desired.  In the above example to sample three rate Intervals type in the number of 3.

Event Setup
Introduction
The Event Setup control is able to manage the entire process of getting temperature data from a live image to hard 
disk, spread sheets, graphs, and AD or DA outputs.  Initiating the collection of data is very flexible with a variety of 
response conditions.  The Control Dialog that controls this is shown below.  It is called the Event Setup. 

THIS IS A VERY COMPLEX CONTROL that needs careful study to apply to its full potential.. 

Contents of the Event Setup section
1. The Event Setup dialog
2. Explanation of momentary conditions
3. Explanation of persistent conditions
4. The 4 kinds of conditions, Object Temperature, Software, Timed, and Hardware Trigure
5. Schematic of Event Setup with related dialog boxes.
6. Flowchart of Event Setup actions

Described below is the control that is available when Events Setup is CLICKED in the Events Menu. On the LEFT 
SIDE are the controls to setup conditions and to display the results. On the RIGHT SIDE are the software responses 
to those conditions. In the next section the user should refer to an overal schematic of this control to understand the 
various controls available to response selections.  

The Event Setup controls

Selecting Conditions
A condition is a source for data originating in a LIVE IMAGE. The software use these conditions to set up the proper 
reporting as a source for data in the Event Setup Controls. Note that a condition can be a cluster of related conditions.  
These are grouped togather initially for convenience in selecting. 

SETUP CONDITIONS  
Object Temperature
Timed
Hardware Trigger
Software Condition

Setup Creation  
Use Add, Edit,
Remove, and
Rename BUTTONS

Setup Description  
Setup Response  
Description  

Setup Response  
Description  

SETUP Response  
For Momentary  

SETUP Response  
For PERSISTENT  



There are 4 possible conditions:
1. Object Temperature
2. Software Contion
3. Timed.
4. Hardware trigger (appears only when an I/0 board is installed in the computer. 

How to select a condition  . . .

Click on Setup Event in the Events menu to open the Setup Events Dialog.   
CLICK on the Down Arrows of the DROP LIST CONTROL,  to open a list of  
three CONDITIONS shown to the right. . Then double click on any one of these  
items to select. 

These conditions are described in the following section.

CONDITIONS 1 - Object Temperature 

Introduction
 These are a group of conditions that use the temperature tools - Point, Spot, Line, Shape, Circle, Rectangle. The dia-
log box shown below displays when this CONDITION IS SELECTED. 

With these conditions the user can extract temperature data from live images and output that temperature data to a set 
of responses.  

 



Object Temperature Event Description 
Events are labled automatically with a designations such as C1, C2, etc.  These cannot be edited. Point Temperature 
Events - is automatically entered by the software. The text of the description is fully editable by placing the mouse 
cursor anywhere on the white area and CLICKING. A rail cursor is presented and the keyboard then is fully accessi-
ble for changes. 

Object 1
CLICK on the DOWN ARROW associ-
ated with the Object 1 DROP LIST, to 
display the list of Temperature tools 
available,  Point, Spot, Line, Circle, 
Shape, and Rectangle. Select any one of 
these temperature tools or OBJECTS by 
DOUBLE  CLICKING on it.  This is 
illustrated to the right, where LINE and 
CIRCLE have selected.  NOTE - POINT OR SPOT is selected and does not display  the Min/AV/Max ENTRY BOX 
, since these TOOLS do not have a Minimum, Average, and Maximum temperature capability.  In the example above 
LINE TEMP and CIRCLE TEMP allow the user to select a Minimum, Average, are Maximum temperature for data.
Indexing. Use the UP Down Arrow to select a different index if needed.  In this case Index 1 for 
Point is being used.  This is illustrated to the RIGHT. 
CONSTANTS - of special note is the fact that 
a constant can be selected in place of a tem-
perature. This allows a factor to to be used 
with the operators shown below. Note also 
that it is possible to set a constant with a tem-
perature value of C, F, or K. F is are shown in the example to the left

Object 2
CLICK on the DOWN ARROW associated with the Object 2 DROP LIST, to display the list of Temperature tools 
available,  Point, Spot, Line, Circle, Shape, and Rectangle. Select any one of these temperature tools or OBJECTS by 
DOUBLE  CLICKING on it. 
NOTE - POINT OR SPOT is selected and does not display  the Min/AV/Max ENTRY BOX , since these TOOLS do 
not have a Minimum, Average, and Maximum temperature capability.  
Use the UP Down Arrow to select a different index if needed.  In this case Index 2 
for Point is being used. 

Operators
The relationship between object 1 and object 2 is further defined by these Math 
Operands: Less Than < , Greater Than > , Less Than or Equal < =, and Greater Than 
or Equal > =.  CLICK on the desired OPERAND to select - the selected relationship 
is shown in the VIEW BOX immediate below.  In this case the Condition is Point 1 > Point 2.

Trigger Types
The software REQUIRES a momentary or persistent trigger selection by the user. 
Persistent Trigger. A persistent trigger explained as a diagram below.. The diagram shows that the nature of such a 



trigger is to remain high or low with a TIME DURATION or TIMED PARAMETER. 

Momentary Trigger. A momentary trigger is explained as a diagram below. Note that this ALWAYS has no timed 
parameter.  

SELECT the kind of trigger very carefully.  Once this is done and OK is CLICKED the software GRAYS OUT this 
item so that it can’t be modified.  The only actions that can be taken is to edit all the other items of the control or if it 
is desired to change the trigger it will be necessary to delete the CONDITION and begin again. 

Trigger Threshold
NOTE: A trigger threshold time sets the AMOUNT OF 
ELAPSED TIME before a RESPONSE occurs.  
Trigger threshold provides ms/Frames, seconds, minutes and 
none for time intervals. The following maximum values can be 
entered:
ms              99999
frames       999
Seconds     999
minutes     99
none
Enter the numbers required in the desired time base of delay. 
Select none if no delay is desired.In the illustration 33 ms was 
set.  The letters ms, sec, min are placed next to the numbers to 
help editing.
Note that time can be in either ms (1000 of a second) or in 
frames which corresponds to 33 ms or 33/1000 of a second. 
This corresponds to a rate of aproximate 33 per second.  Any 
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Persistent Low
Momentary
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number less than or equal to 99999 ms can be entered - the software will then place the correct number of frames that 
occur in that time frame. 
ERROR Messages - 
If greater than the above numbers are entered or no numbers are entered the software will placed an error control 
requesting that a quantity of time be entered, when the OK button is pressed.   This is shown to the right.
When everything is done review the set-
tings again to ensure that the desired 
choices are made correctly and CLICK on 
the OK button.  This is located at the button 
of the CONTROL.

CONDITIONS 2 - Hardware Trigger 
Selected

The CONTROL that results from this 
selection is shown below. NOTE: in this 
condition,  the CONDITIONS originate 
outside the SOFTWARE in the I/O Board 
installed in the computer. Every condition 
has a consecutive label applied - for exam-
ple all are C1, C2, C3, etc. In this case it is 
C2. Which means that it is the second Con-
dition pro
Every condition has a consecutive label 
applied - for example all are C1, C2, C3, etc. In this case it is C2. Which means that it is the second Condition pro-
cessed or setup.
This contains a label, in this case C1, and the condition description - in this case ‘Hardware Trigger’ 
The text of the description is fully editable by placing the mouse cursor anywhere on the white area and CLICKING 

Object 1
Use the UP/Down ARROW to select TTL Pulse, or Contact Closure. The list shown to 
the left is displayed.
I/O Board - a specified number and type of I/O boards or devices having I/O 
can be installed. These are displayed in the associated DROP DOWN LIST, for 
selection. 
Channel.  From the DROP DOWN LIST select from 1 through the number of channels that the SELECTED I/O 
board can support. NOTE - what is displayed depends on the

Text box  The control will now display in a text box all the pertinent hardware information of this selected condition.

Trigger Type
The software REQUIRES a momentary or persistent trigger selection.
SELECT this carefully.  Once this is done and OK is CLICKED the software GRAYS OUT this item so that it can’t 
be modified.  The only actions that can be taken is to edit all the other items of the control or if it is desired to change 
the trigger it will be necessary to delete the CONDITION and begin again. This is done to prevent selecting wrong 
responses. Make sure that the effects of a choices is understood. 



A momentary or persistent trigger have a unique set of responces. See the material in other sections of this manual.  

Trigger Threshold
See the section on Condition 1 
Trigger Threshold for informa-
tion on these settings.

Condition 3 - Timed

The CONTROL that results from 
this selection is shown to the right.  
NOTE: in this condition,  the 
CONDITIONS originate from the 
COMPUTER CLOCK and out-
side the SOFTWARE  
Every condition has a consecutive 
label applied - for example all are 
C1, C2, C3, etc. In this case it is 
C2. Which means that it is the sec-
ond Condition processed or setup.

Event Description
This contains a label, in this case 
C1, and the condition description - 
in this case ‘Timed Condition’ 
The text of the description is fully editable by placing the mouse cursor anywhere on the white area and CLICKING. 
A rail cursor is presented and the keyboard then is fully accessible for changes. The user can edit the supplied 
description as was down in the menu to the left or leave them as it.
The CONTROLS of the TIMED Event Setup
A timed event is best understood by understanding that there are three interlocking components in this CONTROL.  
A. The Start Method, which controls when the Reponses set up in the Event managers begin to take place.  
IMMEDATE START - the responses begin when the Event Manager is CLOSED. 
A set time - in 24 hours format 
Hardware trigger - from the installed I/O board.
B. The Envelope which controls how many responses occur.
Persistent - responses run continuously
Momentary - either timed or hardware control by contact closure, controls when the responses occur. A repeat every 
setting can only be set when momentary is checked.

C. The Duration/END which controls when an envelope is terminated. Duration set in DAYS, HOURS, MINUTES, 
SECONDS. At the end of this time the envelope is terminated. 
Envelope is terminated when time set in 24 hour format is reached.
Set a number of responses, by number, when the envelope is terminated.
Hardware trigger, by CONTACT CLOSURE in the installed I/O board.
Study carefully the timming chart, which describes all the possible effects on a SET OF RESPONSES, by using the 
timed condition, located at the end of the chapter.  

Condition 4 - Software



Introduction

This condition works with either the remote or with a mouse and 
the special toolbar shown below.   To use from a the REMOTE 
depress any of the number buttons 0 through 9.  This is the REA-
SON why it is CALLED SOFTWARE.

Software Condition Setup
Events are labled automatically 
with a designations such as C1, 
C2, etc.  These cannot be edited. 
Point Temperature Events - is 
automatically entered by the 
software. The text of the 
description is fully editable by 
placing the mouse cursor any-
where on the white area and 
CLICKING. A rail cursor is pre-
sented and the keyboard then is 
fully accessible for changes. 

Software Condition ID
Select a number from 0 through 9 that will identify the Condition to the software.  Use the drop down LIST BOX.
A selected number is initially gray but becomes black or active when Set Event dialog box is closed. That number is 
activated by pressing the same number on the remote or clicking on it with the mouse. 

All of the numbers on the Software Conditions can be made ACTIVE and can be used to accomplish different tasks. 

Trigger Type
Select Persistent or Momentary.  
Special Note
Persistent has the has a LATCHING EFFECT so that depressing the button will cause it to remain ON, until it is 
CLICKED again.  
Momentary will respond to a DEPRESSING the REMOTE NUMBERS, or a Mouse CLICK.  As long as the button is 
held down the SOFTWARE CONDITION is active. Releasing the button turns it OFF.

Selecting Conditions

The available conditions 

Move the Mouse Cursor to the section of the Event Setup called ‘Setup Conditions’ and CLICK on the Down Arrows 
of the DROP LIST CONTROL, to obtain a list containing the three items described next.

Selecting Responses
Keep in mind that the software can have multiple responses and will sequentially run each.  Because there are several 
responses that overide a Contion, the setting up a CONTION/RESPONSE series of events can become complex.  The 
brief descriptions below should help this process. 



The available Responses 

Move the Mouse Cursor to the section of the Event Setup called ‘Setup Conditions’ and 
CLICK on the Down Arrows of the DROP LIST CONTROL, to obtain a list containing 
the three items described next.

Responses to Momemtary Conditions
1. Save Once - Save an image from a selected ROI into a user selected file.
2. Log Data - Log data from a temperature object into a user selected file
3. Start Periodic Saves - Begin repeated save with a duration that OVERIDES a 

set condition. 
4. Abort Repeated Saves - End repeated saves and reset the Condition that initi-

ated the repeated saves. 
5. Start Periodic Logging - Begin repeated logs with a duration that OVERIDES 

a set condition.
6. Abort Periodic Logging  - End repeated logs and reset the Condition that initiated the Start repeated log.
7. Display Alarm Windows - Initiate ALARM message on the computer - either LATCHING or NON 

LATCHING.
8. Movie Save - Begin saving settable number of images, becomming the ONLY task, and then ending.
9. Instant Save
10. Analog Output - Requires an AD board - allows analog output from MIN, MAX, AV temperature objects.

Responses to Persistent Conditions
1. TTL output - change the state of a I/O TTL channel when intiated by a Condition.
2. Analog Output - OUTPUT a 0 to 20 MA output to I/O channel from a selected temperature object when ini-

tiated by a Condition.
3. Reapeatedly Save - Overide a normally constant output and periodically save data from a ROI.
4. Repeatedly log - Overide a condition and output and log data from a selected temperature object.                                       

Responses to Momemtary Conditions 

RESPONCE 1 - Save Once

Introduction

This function will save an image from the LIVE WINDOW 
with the ATTRIBUTES inherent in the file type selected in 
File Type.  

How to use . . .

CLICK on Save Once in the drop down menu described in the 
previous section.  That will display the dialog box shown to 
the right.  

Event Description
This contains a label, in this case C1, and the condition description - in this case ‘Save One Image.’ 

The text of the description is fully editable by placing the mouse cursor anywhere on the white area and CLICKING. 
A rail cursor is presented and the keyboard then is fully accessible for changes. The user can edit the supplied 



description as was down in the menu to the left or leave them as it. 

Name of Image File
Use the Browse button to find the directory or to set the directory in which the Image is saved. Long file names are 
permitted.  Some of the file types such has my file %m%d%y

Select ROI
Using the down arrow in the Drop List Box select a previously setup ROI. It is from this region that an image file will 
be save.

File Type

case '%': 
    Result+= "%"; 
    break; 
   case '#': 
    ParamCount++; 
    bIncSeqNumber = TRUE; 
    Result+= Str(SeqNumber); 
    break; 
   case 'd': //Day of month as decimal number (01 - 31) 
   case 'H': //Hour in 24-hour format (00 - 23) 
   case 'I': //Hour in 12-hour format (01 - 12) 
   case 'j': //Day of year as decimal number (001 - 366) 
   case 'm': //Month as decimal number (01 - 12) 
   case 'M': //Minute as decimal number (00 - 59) 
   case 'p': //Current locale’s A.M./P.M. indicator for 12-hour 
clock 
   case 'S': //Second as decimal number (00 - 59) 
   case 'x': //Date representation for current locale 
   case 'X': //Time representation for current locale 
   case 'y': //Year without century, as decimal number (00 - 99) 
   case 'Y': //Year with century, as decimal number 



The following file types are available.   
Jpeg Images - Save images in a JPEG compatable format.
Single  Frame ROI - Save a ROI, which can be a entire image or a selected 
ROI.  
Thermosoft Image - Special file format that saves everything annotated on 
a live image. 
Tiff Images -   Save images in a TIFF compatable format.
Windows Bitmaps - Save images in a BMP compatable format.  

RESPONCE 2 - Log Once

Event Description
This contains a label, in this case C1, and the condition 
description - in this case ‘Log One Item’  

Edit type of Responses 
A list of temperature objects previously placed on the 
LIVE IMAGE will be displayed.  Select any one or ANY 
NUMBER OF THEM for loging.  Temperature objects 
having a MAX, MIN, AVG will need to have any one or 
ALL OF THESE selected.

Select Log File Name
CLICK on Browse to set up a directory and select a file 
name. 

List of Objects
It is necessary to place the temperature objects to fill in 
this section.  In this case a Line and Rectangle were 
placed on the LIVE IMAGE.  The user than checks the items that are to be logged.  In this example it would be Max 
for Line, and Average of Rectangle.  

RESPONSE 3 - Start Repeated Saves
This function saves the entire LIVE IMAGE repeatedly.
Event Description
This contains a label, in this case C1, and the condition 
description - in this case ‘Save Repeatedly.’ 
The text of the description is fully editable by placing the 
mouse cursor anywhere on the white area and CLICKING. A 
rail cursor is presented and the keyboard then is fully accessi-
ble for changes. The user can edit the supplied description as 
was down in the menu to the left or leave them as it. 

Name of Image File

Select a file, directory or create a file for the Repeated Saves. 
An extension can be provided by the user.

Timed Functions
It is very important that the software user understands that the timed functions in this control - PERIOD and DURA-
TION will OVERIDE those set in TIMED Conditions. The user can then set these times without regard to the 



timed setup in Conditions.

Period 

Select any of the above time bases or an external trigger .
This function sets HOW OFTEN Repeated Save OCCURS.
Duration 
Set the time in DAYS, HOURS, MINUTES, SECONDS, when the Repeated Save responce ends. 

RESPONSE 4 - End Repeated Saves

This function ENDS  -  Repeated Save. The control below shows that there are two conditions with a  Save Repeat-
edly.  This control will CLEAR the selected Repeated Save when End Repeated Save is PROCESSED by the soft-
ware.  
NOTE: be very aware that this control CLEARS OR ABORTS a Repeated Save. 

Event Description
This contains a label, in this case C1, and the condition description - 
in this case ‘Save One Image.’ 
The text of the description is fully editable by placing the mouse 
cursor anywhere on the white area and CLICKING. A rail cursor is 
presented and the keyboard then is fully accessible for changes. The 
user can edit the supplied description as was down in the menu to 
the left or leave them as it. 
Condition Selection
CIR1, and C2R2 are both listed. This control will list all the Condi-
tions with a Repeated File Save Responce.  Select any one or all of 
these and  CLICK OK to save this Responce.

If selected - as long as
this I/O Channel INPUT
remains POSITIVE the
RESPONSE continues.

Responce occurs every
time this time elapses,
SECONDS, MINUTES,
or HOURS.

A Condition/Responses with TIMED CONDITION



RESPONSE 5 - Start Repeated Log

This function saves the entire 
LIVE IMAGE repeatedly.
This contains a label, in this case 
C1, and the condition description - 
in this case ‘End Repeated Save’ 

The text of the description is fully 
editable by placing the mouse cur-
sor anywhere on the white area 
and CLICKING. A rail cursor is 
presented and the keyboard then is 
fully accessible for changes. The 
user can edit the supplied descrip-
tion as shown in the menu to the 
left or leave them as it. 

Log File
Select a file, directory or create a 
file for the Repeated LOGS. 
An extension can be provided by 
the user.

List of Objects
The list box displays ALL the temperature objects placed on the live screen.  Select as many of these as desired for 
logging. Also select a MIN, MAX, AVG for the object if it applies. The user will be unable to apply these to objects 
that do not have this capability.

Repeat Every 
It is very important that the software user understands that the timed functions in this control - PERIOD and DURA-
TION will OVERIDE those set in TIMED Conditions. The user can then set these times without regard to the 
timed setup in Conditions.

If selected - as long as
this I/O Channel INPUT
remains POSITIVE the
RESPONSE continues.

Responce occurs every
time this time elapses,
SECONDS, MINUTES,
or HOURS.



Select any of the above time bases or an external trigger .This function sets HOW OFTEN Repeated Save OCCURS.
Duration Set the time in DAYS, HOURS, MINUTES, SECONDS, when the Repeated Save responce ends. 
CLICK OK to save this control and return to the previous CONTROL.

Duration/End
Select from any of the methods of Duration/End by 
entering HOURS, MINUTES, or SECONDS. An 
external trigger originating from a TTL board does 
not have a time associated with it.

RESPONSE 6 - End Repeated Log

This function ENDS  -  Start Loging Repeatedly. The control below shows that there are two conditions with a  Start 
Loging Repeatedly.  This control will CLEAR the selected  Start Loging Repeatedly when End Repeated Log is PRO-
CESSED by the software.   

Event Description
This contains a label, in this case C1, and the condition description - 
in this case ‘End repeated log.’ 
The text of the description is fully editable by placing the mouse 
cursor anywhere on the white area and CLICKING. A rail cursor is 
presented and the keyboard then is fully accessible for changes. The 
user can edit the supplied description as was down in the menu to 
the left or leave them as it. 

Condition Selection
This control will list all the conditions with a repeated log response. 
Select any or all of these and CLICK OK. 

RESPONSE 7 - Display Alarm Message

Multiple alarms use the same popup alarm display - the only difference is that the specific ALARM TEXT is listed, 
for identification. 
A simple means of displaying an ALARM message on the computer screen ONLY.

Event Description
This contains a label, in this case C1, and the con-
dition description - in this case ‘Display Alarm 
Message.’ 
The text of the description is fully editable by 
placing the mouse cursor anywhere on the white 
area and CLICKING. A rail cursor is presented 
and the keyboard then is fully accessible for 
changes. The user can edit the supplied descrip-
tion as was down in the menu to the left or leave 
them as it. 

Alarm Message
Enter a 60 character message making up the alarm 
message. Only 13 characters can be seen without 
scrolling. Decide on making this a LATCHING 
alarm message, in which case the user can RESPOND to the Alarm and remove it, by CLICKING on a Menu Button 



on the Alarm Message Box. Or make it a non-latching alarm message.

RESPONSE 8 - Fast Image Save

Saves a series of repeated images to a file.  VCR like Control ICONS allow viewing of these images.

Event Description. 
This control when operating requires a large percentage of com-
puter time.

This contains a label, in this case C1 and a condition descrip-
tion. 

The text of the description is fully editable by placing the 
mouse cursor anywhere on the white area and CLICKING. A 
rail cursor is presented and the keyboard then is fully accessible 
for changes. The user can edit the supplied description as was 
down in the menu to the left or leave them as it. 

Select ROI
The software has a ROI editing tool that allows placement, editing, and filing for retrieval, of multiple ROI’s.  See 
Chapter 6 of this User’s Guide. These will be listed in the Select Roi Drop Down List.
Save Context Frame
Enable the saving of one STATIONARY ENTIRE IMAGE, which is the context of the ROI at the end of a frame.

Duration
Set the time in number of Frames, milliseconds, or 
seconds, that this response will take. This overides 
the settings in the associated Condition. 

Responce to Persistent Conditions

RESPONSE 1 TTL Output 

Response Description. 

This contains a label, in this case C1, and the condi-
tion description.  

The text of the description is fully editable by plac-
ing the mouse cursor anywhere on the white area 
and CLICKING. A rail cursor is presented and the 
keyboard then is fully accessible for changes. The 
user can edit the supplied description as was down 
in the menu to the left or leave them as it. 

Edit Type of Response



Channel
The AD board selected for use with this software has 4 input and 4 output channels for TTL output. Select 1 among 
those available. 
IO Board
AT AO -10 is normally displayed and supplied from a driver.
High/LOW
Select if the TTL output is HIGH or LOW
Latching or Non-Latching
Select if the TTLE output is to Latch

RESPONSE 2 - Analog Output

To display as a response requires that a AD board be installed in the computer. This information is included to 
conver the case where the user needs additional information and wants a AD board.

Output a 4 to 20 ma signal, from a temperature object. 
The output is proportional to a temperature. Example if a point reads 600 degrees, and the temper-
ature span is 400 to 800 degrees, the output would be 12 ma.  Obtain the span information from 
the numbers in parentheses (600 and 700) on the Color Bar Tool, shown to the right.

Event Description. 

This contains a label, in this case C1, and the condition description.  

The text of the description is fully editable by placing the mouse cursor anywhere on the white 
area and CLICKING. A rail cursor is presented and the keyboard then is fully accessible for 
changes. The user can edit the supplied description as was down in the menu to the left or leave 
them as it. 

Edit Type of Response

List of Objects. Temperature objects placed on the screen
are displayed in a List Box.  Select 1 of these for an output.

Since POINT or SPOT object due not have min, max, avg 
values the this control will not display an Avg, Min, or Max 
check boxes. 

Select and Avg, Max, or Min, or only one, and select an 
output channel for that selection. An I/O board can be 
selected for any one of these.

 RESPONSE 3  - Save Images to Disk Repeatedly

Save images from a ROI to a file for a set amount of time.
Event Description. 
This contains a label, in this case C1, and the condition description - in this case ‘Save to a Disk Repeatedly.’ 



The text of the description is fully editable by placing the mouse cursor anywhere on the white area and CLICKING. 
A rail cursor is presented and the keyboard then is fully accessible for changes. The user can edit the supplied 
description as was down in the menu to the left or leave them as it. 

Edit Response
Browse
Select a file in which to save images.

Select ROI
The software has a ROI editing tool that allows placement, 
editing, and filing for retrieval, of multiple ROI’s.  See 
Chapter 6 of this User’s Guide. These will be listed in the 
Select Roi Drop Down List.

Duration
Set the time in number of Frames, milliseconds, or sec-
onds, that this response will take. This overides the settings 
in the associated Condition 

RESPONSE 4 - Repeated Log  

This function saves the entire LIVE IMAGE repeatedly.



This contains a label, in this 
case C1, and the condition 
description - in this case ‘Log to 
a file repeatedly’ 
The text of the description is 
fully editable by placing the 
mouse cursor anywhere on the 
white area and CLICKING. A 
rail cursor is presented and the 
keyboard then is fully accessi-
ble for changes. The user can 
edit the supplied description as 
shown in the menu to the left or 
leave them as it. 

Condition Selection
CIR1, and C2R2 are both listed. 
This control will list all the 
Conditions with a Repeated File 
Save Responce.  CLICK OK to 
save this Responce.

Edit Type of Response
List of Objects
The list box displays ALL the temperature objects placed on the live screen.  Select as many of these as desired for 
logging. Also select a MIN, MAX, AVG for the object if it applies - POINT and SPOT temperature objects do not 
have a Min, Max, and Avg. 

Name of Log File
Select a file, directory or create a file for the Repeated Saves. 
An extension can be provided by the user.

Duration
Set the time in number of Frames, milliseconds, or seconds, that this response will take. This overides the settings in 
the associated Condition 

Log on to Spreadsheet
This function sends data from a any temperature object to a spreadsheet such as Excel. Temperature objects are 
selectable and Max, Min, or AVG can be set.

This control only SUPPORTS Excel shipped with Office 97 or 97 

How to -- 



Have a LIVE IMAGE displayed on the screen. 
Have the Excel spreadsheet running. 
Place temperature objects on the LIVE IMAGE , such as Points, Line, Shape.

Then CLICK on the Events Menu and 
CLICK on Log to a Spreadsheet. The con-
trol shown to the left displays.

Select the time INTERVAL for sending data 
to the spreadsheet.  For example - select 1 
hour - then each hour data would be sent. 
Select the the temperature object.  In the 
illustration shown on the left Line 2 is 
selected. Select from Max, MIN, AVG read-
ings.  All of these can be selected. 

CLICK OK and information is sent to 
Excel.

Acknowledge Alarm
The alarm message or TTL Alarm output are the ONLY alarms that are acknowledged.  
When these alarms take place a dialog like that shown below is display on the screen.  
CLICK on the Acknowledge Alarm(s) button to silence the alarm. 

The alarm conditions continue and when another alarm takes place it is placed on the 
screen and the software user will ONCE AGAIN need to acknowledge the alarm.

The Menu item in Events does exactly the same thing.  It is probably more convenient 
to use the popup dialog shown to the right.

Schematic of Events 
Note - Response to Momemtary Conditions follows through for several pages. In each page the Response to 
Momemtary conditions is repeated on each page, with the exception that a line is drawn from the dialog box to the 
Condition.
The purpose of this schematic representation of this very complex control to provide the user with some sense of the 
many possibilities for managing and reporting data. 
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A Condition/Responses with TIMED CONDITION

C Duration or End

A START Method- determine
how the RESPONCE BEGINS

Start Responces
IMMEDIATELY

Select HARDWARE I/O
Channel to START response

B Envelope

C

Once a repsponse begins it runs
CONTINUOUSLY until an END  in  Duration/
End occurs

Sets how long the responses
take place in DAYS, HOURS,
MINUTES, SECONDS when
responses END.

ACTUAL COMPUTER TIME
24 HOUR FORMAT - Sets time
when response ends.

Enter how many
readings will take place
before responses end.

Select HARDWARE I/O
Channel to END
Responses.

Responses
See the section of this chapter on
responses.
ALL THE SPECIFICATIONS  TO
RESPONSES APPLY.
Example - each of these could have
MULTIPLE RESPONSE EVENTS
IN SEQUENCE.

ACTUAL COMPUTER
TIME  24 HOUR
FORMAT - Sets time
when response
BEGINS.  Example
16:35:20

A

B

If selected - as long as
this I/O Channel INPUT
remains POSITIVE the
RESPONSE continues.

Responce occurs every
time this time elapses,
SECONDS, MINUTES,
or HOURS.









The Edit Menu
Introduction

Location
 A is located in Frame Grabber Module and Image Editor. 
B is located in Template and Report Editor, and C is 
located in Graph Module. 

These functions are found in the Edit Menus.
 

1. Undo
2. Redo
3. Cut
4. Copy
5. Paste
6. Edit Objects
7. Duplicate
8. Delete Objects
9. Remove All Objects

Related Topics 
Chapter 4 Using the Software. Review sections on Editing 
Objects.

The Edit Menu Functions
The Edit Menu contains FUNCTIONS that allow the soft-
ware user to edit ANY OBJECT placed on the screen. 

Undo  
Use this tool to undo a previous edit activity.  Example 
delete and object - use Undo remove Object to restore. There are 25 levels of undo.

The undo function changes its words to indicate what is will take place.  Example - place a LINE TEMPERATURE 
object on the image.  If it is selected Undo changes to that shown below. 

Use the SHORTCUT KEY Ctrl Z to speed undo. 

Redo 
Undo the previous undo. Example last action was to undo an object delete. Redo restores this object to what it was 

  A

  B  C



prior to the last action. There are 25 levels of redo. 

SHORTCUT KEY Ctrl Y

Cut
Copy an object to the Windows Clipboard and remove from the image. Objects such as temperature, cad shapes, text 
can only be cut and pasted back into the software module that was active at the time of the cut.  Entire images can be 
cut and pasted to other programs.

SHORTCUT KEY - Ctrl X

Copy
Copy an object to the Windows Clipboard. Objects unique to the software like, temperature, cad shapes, text can only 
be cut and pasted back into the software module that was active at the time of the cut.  Entire images can be COPIE  
and pasted to other programs.

NOTE: Make sure that all OBJECTS are deselected prior to attempting to COPY an image.

Paste
Move an object from the Windows Clipboard to software.  There is no limit on the kinds of objects that can be pasted 
back into the software.

NOTE: the software places the object over the last object so that IT IS NOT VISIBLE. Paste is grayed until and 
object is located in CLIPBOARD.

SHORTCUT KEY Ctrl Z

Edit Objects
The mouse cursor must be an ARROW CURSOR before any objects can be selected and EDITED.  CLICK on EDIT 
to change the mouse cursor changes into a cursor.  

Duplicate Objects
Make exact copies or duplicates of an objects.  Any object can be duplicated with this function. This function is very 
handy for replicating temperature objects. After the required number are duplicated the user can move them to the 
required location. 
How to . . . 
Select the object first.  Then CLICK on Edit and CLICK on Duplicate Objects.  A copy of the object will be made. 
NOTE: USE Ctrl D to do the same thing a much easier way of doing this. 

Delete Objects
Remove or delete a selected object.

Remove All Objects
Removes every object from the active image screen.



The File Menu Location
A file menu or a variation of the file menu is located in the Frame Grabber 
Module, Graph Module, Image Editor, and Report Editor.

The File Menu 
Start Menu
 The Menu Bar displayed, when the program ’boots’ is shown below.

CLICK on File to show the MENU displayed to the right.The functions in 
the FILE menu associated with the Start Menu are

1. Open
2. Preferences
3. Toolbars
4. Recent File List
5. Exit

Frame Grabber Module
The Frame Grabber Menu Displays when RUN is Selected in the 
Framegrabber Menu.The functions associated with the Frame Grabber-
Menu are:

1. Open
2. Close
3. Save Events
4. Load Events
5. Preferences
6. ToolBars
7. Recent File List
8. Exit

Image Editor Module
The Image Editor Module is reached by either loading an Image file by 
using the File Menu and Load, or by running the Framegrabber and THEN 
CLICKING on Edit Image.

The functions in the File Menu associated with the Image Editor module 
are:

1. Open
2. Save
3. Save All

  Start File Menu

  Frame Grabber File Menu

Image Editor File Menu



4. Preferences
5. Toolbars
6. Print
7. Print Preview
8. Print Setup
9. Page Setup
10. Recent File List
11. Exit

Template, Report Editor and Graph Modules
The functions in the File Menu associated with the Report Editor mod-
ule, Template Module and Graph Module are identical.  They are:

1. Open
2. Import
3. Save
4. Save As
5. Save All
6. Close
7. Preferences
8. Toolbars
9. Print
10. Print Preview
11. Print Setup
12. Page Setup

File Menu Introduction
The File Menu contains a group of functions needed to save and load every kind of file generated by the software,  the 
preference control or customizer, printing controls, print setup, print preview, page setup, and EXIT.

The FILE MENU is the ONLY place from which the user can exit the software. 

The File Menu Functions 
Open
The software can open the following file formats. CLICK on File, then CLICK on OPEN.  A standard Windows file 
open control will then display.  CLICK on List Box down arrow shown to the right and CLICK on any of the file 
formats to display a directory list of files in the selected formats. 

The software saves directory locations so that saved files will automatically load from the correct directory. Note: 
The software is capable of loading multiple BMP and TIFF and Graph files.  HERE IS HOW - depress and hold down 
the control key  and then Left Mouse Click each file to be loaded. Then CLICK OK. The software will then load all 
the images. Use Windows Menu - Tile or Cascade to view the results. 

Template, Report Editor, 
Graph Modules



File Formats

The kinds of file formats loaded by the software is as follows.
1. Thermosoft Images - 32 bit Images. 
2. Tiff Images
3. Jpeg Images
4. Single Frame ROI - files obtained with a Condition 

Response.
5. Avio 100 Images
6. EIC 16 bit bitmaps.
7. Avio 2000 and 2000 MK2
8. Avio 8000 images.
9. Irris/IRC 160 Images
10. Irris/IRC 256 Images
11. Thermosoft Reports
12. Thermosoft Templates
13. Replay Files
14. Thermosoft Graph

NOTE: Loading the file will in ALL CASES bring the software to 
the proper module or location and initialize the proper software 
function to view the files. Example - opening a template will move 
the software to the Report Editor and make it possible to edit that 
template.  This means that the user can be located in any module, 
begin some new work in another module by loading a file, and then 
return without loosing the original work. 

Save As
Save a file to a file formats shown to the RIGHT. What formats are 
displayed, or available, depends on which Module is active. For 
example in the Report or Template Module Thermosoft Report or 
Thermosoft Templates are available.

 A standard Windows File SAVE AS is used. 

Export
Export a GRAPH to either a CLIP Board or to a File.
How to . . .
Load and get a graph running.  Then CLICK on Export.  The CON-
TROL shown to the RIGHT is displayed. 
Exporting -
Export to MetaFile - Use Windows MetaFile format to export the 
graph.
Export to BMP - construct a bitmap of the graph.
Text - CLICK on Text and the CONTROL shown to the left pops up. 
Select ALL the DATA or only a selected PORTION.
Choose to send DATA or DATA and LABELS
Data to Export - Y Axis Values or Point Number
Export Style - Choose to use a table - LEFT TO RIGHT or a simple 
VERTICLE LIST.

File Save As Formats

Graph Export Controls



Row vs ColumnNumeric Precision - use 
that set in the graph or use the maximum 
precision of 3 decimal places.

Save All
This function is a convenient way to 
SAVE EVERYTHING.

CLICK on SAVE ALL will cause the 
software to cycle through all of the WIN-
DOWS EXISTING in the software and 
save them.  Example - if a template, an 
image, a graph, and a report exist in the 
software - this function will attempt to 
save all of them.   

It will use a file name that pre-exists for a 
window - if one does not exist the soft-
ware will request that a file name be sup-
plied. NOTE - the software selects the 
CORRECT FILE FORMAT in every 
case for a proper save.  In the WIN-
DOWS CONTROL shown above - 
Thermosoft template format is 
selected.

Save Events

Introduction

This function makes the software easier 
to use.  The Event Manager to which it 
applies exclusively can have difficult to 
setup, and even more difficult to remem-
ber settings.  This functions performs all 
those tasks for the user.

It will also reload the IR image and the 
OBJECTS associated with that image.  
and a Event Manager USE. 

In the example shown to the right two 
temperature objects Point 1and Point 2 
along with TEXT were saved with the 
Event Manager Settings are shown 
below the image. 

How to use . . .

1. Set up everything - the Event 
Manager, Live Images, Temper-
ature Extractions, Files, etc.Run the EVENT to make certain that everything functions correctly.



2. Then CLICK on File, and CLICK on Save Event.  Pro-
vide a LONG FILE NAME that is descriptive.  The 
user is free in the file control to setup new FOLDERS 
which are also LONG FILE NAMES and can be 
descriptive.

Load Events
Load Events reverses the above process.  To use CLICK on 
Frame Grabber and CLICK on Run. Or use the TOOLBAR that 
does the same.  Then CLICK on FILE and CLICK on LOAD 
EVENTS.  Select the proper file and reload.

Preferences 
See Chapter 4 setting up and initializing the software

Print 
This function performs printing of a selected images with anno-
tations, Graphs, and Reports. A standard Windows Print Con-
trol is used, as shown to the right. 

Preview

Uses of print preview

Image Editor - displays the selected image as it will be printed.
Graph - displays the selected graph as it will be printed.
Reports - displays the selected Report as it will be printed.
Templates - displays the selected Template as it will be printed.

Print preview functions

Print Preview 
CLICK on Print Preview and the Menu shown above pops up. 

Print - print exactly what is viewed.
Next or Prev Page - moves the view forwards or backwards 
through all the available pages.
Two Page - view two pages on the computer screen.
Zoom In or Out - reduce or enlarge apparent size of viewed 
object.
Close - exit the view function.

Print Settings
Opens the Standard Windows Control supplied by the printer 
manufacturer.  We these all of settings applicable to that printer 
are available to the user.

Print Settings in the Image Editor and Graph 
Module

Page Setup used in the Template and 
Report Module. 

Printer Settings Control



Page Setting

Margins

Use these to control the margins used during a print of an image or a report.  

Image Size

Set the image size as a percentage. 
NOTE - if percentage is set to 100 % the largest image permitted by the MARGINS and the REQUIREMENTS of 
THE CORRECT ASPECT RATIO will be printed.  
Set the image size in inches. 
Print an image to the size allowed by Margins if size is larger than margins permitt, otherwise print the exact size.  
Aspect ratio is not observed. 

Most recent File List
A list of the most recent files loaded into the software is displayed.  CLICK on these to load. 

Exit
CLICK on this to close the software.  A warning about unsaved work may appear depending upon work status.



Menu
The Frame Grabber MenuLocation

The Frame Grabber Menu is found in the START UP Module 
, the Image Editor Module, and the Frame Grabber Module.

The Frame Grabber Menu functions

Startup Menu

(Located in the Startup Window, and Image Editor). The star-
tup window is where the software opens when started. 

1. Run
2. Freeze

Image Menu
1. Run
2. Freeze
3. Edit Image
4. Camera Controls
5. Adjustments 

Related Toolbars
NOTE - a tool bar called framegrabber can access all the 
functions RUN, FREEZE, and EDIT or PROCESS.

Related Topics
There are no directly related topics.  

Be sure to note the fact that RIGHT MOUSE CLICK brings 
up a special speed menu as in all other modules of this soft-
ware.

Introduction to the Framegrabber 
Menu

The Framegrabber Menu contains functions that will control 
the display of images from the camera so that it:

1. is can be shown as a LIVE IMAGE, frozen (not live) 
but the software remains in the frame grabber mod-
ule,

2.  or Edit Image which is PROCESS
3. and where the image is frozen and moved to the 

             Startup Menu

Image Menu

Frame Grabber Toolbar

Speed Menu example



Image Editor. This also bring the user to the Image Editor. 
Camera Controls - settings that affect a camera in specific ways.  These functions make changes to the way in which 
the camera operates.
A set of temperature related functions control scene emissivity, scene transmission and a setting for ambient tem-
perature. Ambient temperature finds a use for image annotations and in reports sincere there are fields that report 
these.

The Frame Grabber Menu Functions

Run Mode
Display a live image on the computer screen. Live means to display successive video 
frames at frame grabber rate. The title bar of the LIVE IMAGE WINDOW will display 
the following to tell the user which window is displaying what.
This function is hardware dependent. The user must have a connected VIDEO SIGNAL 
to the frame grabber. 

NOTE - the status bar as shown above will say Framegrabber to indicate in which mod-
ule the software is running.

Run mode is also accessed by CLICKING on the RUN FLAG as shown in the tool bar 
above.

Freeze Mode
CLICK on this to stop successive display of frames and display one frame ONLY. The software will remain in this 
mode until RUN MODE is again CLICKED. The software also remains in the Frame Grabber Module and the soft-
ware status bar will indicate framegrabber.

The title bar of the image will display frozen as shown to the left. 

Edit Mode
CLICK on this function to CAPTURE  (process) 1 frame and move THAT RESULTING 
FRAME to the Image Editor for processing or editing.

NOTE: the software continues to display a LIVE IMAGE with a FROZEN IMAGE 
behind it.  CLICK on the title bar of the window - the part that says Image3, illustrated to 
the right, to access the Image Editor and begin processing the Image. The Status Bar will 
display 

This makes the Image Editor available. NOTE - the status bar then says Image Editor as 
shown to the right. 

Return from Edit mode by LEFT CLICKING anywhere on the Frame Grabber Window 
(assumes a monitor was large enough or the LIVE IMAGE, or was not removed by CLICKING on the x in the upper 
right hand corner of the window. Or return by using the Frame Grabber Menu and selecting RUN or FREEZE. Or by 
using the toolbar.



Camera Controls
These duplicate the controls found on a IRRIS type of camera.

Bri Up (Brightness ) - Increase the camera image brightness.
Bri Down (Brightness) - Decrease the camera image brightness.
Gain Up (Contrast) - camera image contrast adjustment.
Gain Up (Contrast) - camera image contrast adjustment.
Range - Change the RANGE OF TEMPERATURE the camera RESOLVES.
Freeze - cause camera to stop updating - hold an image for adjustment. The software 
continues to update with LIVE IMAGES. 
Auto Bri - turn on auto-brightness.
Invert - switch black to white and white to black.
C/F Toggle (Units) - Celsius, DV, Kelvin, or Farenheidt.
Overlay - have camera supply overlay information, this is DISPLAYED ONLY 
THROUGH VGA OR NTSC.
FOV - Field of view - if AUTO FOV is present.
VGA/NTSC - switch camera to VGA display or NTSC or RS-170 output. 
Focus in - camera focus if AUTO FOCUS OPTION is present.
Focus out - camera focus if AUTO FOCUS OPTION is present

The items in parentheses are used on the REMOTE. 

Adjustments

Clicking this displays a dialog box with Contrast and Brightness adjustments.  This dialog is grayed out when a digi-
tal capture card is installed. What appears in this dialog box will depend upon the frame grabber installed. 





The Image Menu
Location
Frame Grabber, and Image Editor module.

The following functions are 
found in the Image Menu

 1. Load Palette
 2. Adjust Palette
 3. Apply Palettes to all Images
 4. Color
 5. Gray
 6. Display Isotherm
 7. Isotherm
 8. Set Scene Emissivity
 9. Set Scene Transmission
 10. Set Isotherm
 11. Show All Objects
 12. Image Subtraction

Related topics
These should be reviewed when studying any of 
the EVENT MENU CONTROLS.

1. Editing objects chapter 4.
2. Using the mouse chapter 4. 
3. Speed menus chapter 4
4. Preferences chapter 4
5. Edit menu. 
6. GLOSSARY.

The Events Menu
This menu  data in a variety of different ways. It 
will  require a lot of detailed study to apply effectively.  

NOTE the BLACK (white if highlighted) arrow next to Display Isotherm and Image Subtration.  This means a 
pop OUT sub menu exists for those items. 

Introduction to Image Menu
This menu provides functions that deal with the colors, isotherms, how color is displayed, showing objects. It also has 
a filter function.  Image subtraction controls the display of image in relation to another image.  



Display Menu Functions
Load Palette

CLICK on Palette to access a standard Windows file load CONTROL. Use this to select and apply palettes to images. 

Palettes cannot be applied to Files saved, and subsequently loaded back into the software. These are BMP, 
TIFF, or JPEG files.  

Adjust Palette

Even though sample palettes are provided with 
the software there may be a need for a custom 
palettes.

The greatest use of this control lies in the tou-
chup or emphasis of a color to a band of colors. 
Prior to doing this review the topic of Isotherms 
in this chapter to see if that is better suited to 
color emphasis.

Save
Save a modified palette with a new file name or 
replace an existing palette.

Cancel
Cancel an editing session and return to the 
selected MODULE.

Load
Load a palette from existing palettes.

Apply Mod Palette
Apply the results of editing a palette to an 
image - but not save the image.

Color Bar
A color bar is placed at the bottom of the con-
trol.

This replicates the color rectangle of the Color Tool Bar.  The attached temperature scale makes it easier to locate and 
adjust colors to a specific temperature.

Carets
The color bar is always active.CARETS can be placed on the edge of the COLOR BAR. Notice the two that are 
placed on the bar. These are used with SMOOTH, and CHUNK, and any of the COLOR BUTTONS. 

Only two CARETS can be created and placed on the color bar.

How to CREATE CARETS.  
Place the mouse cursor ANYWHERE INSIDE COLOR BAR and CLICK the Left Mouse Button to CREATE THE 
FIRST CARET.  

COLOR BAR

CARET

Temperature scale

Out of Camera Range

Out of Camera Range



To CREATE and place a second CARET, don’t release the button, but continue to HOLD it DOWN and DRAG 
(MOVE) the mouse to the LEFT or RIGHT.  

CLICKING  the Left Mouse AGAIN  in a different location on the bar will SNAP the first caret to a new location. 
The process of creating a second caret in a new location can be repeated. 

Color Buttons
Apply TWO CARETS to the color bar. CLICK one of the COLOR BUTTONS to apply that color to the area of 
between the two carets.  
Chunk
Apply TWO CARETS. CLICKING on CHUNK to create the average of the colors between those two carets.

Smooth
Apply TWO CARETS.  CLICK on Smooth tol blend the colors between the carets.  It creates as many colors for that 
area as there are Palette Indexes, of which there are 256 for the entire color bar.

Color
CLICK on this function to display a loaded palette. The icon next to Color will be depressed (3D) showing that it is 
selected and images will display a color palette.

This is a TOGGLE FUNCTION.  CLICK Gray to undo this SELECTION. Or load a new image and revert to the 
default selected in Preferences. 

Gray
CLICK on this function to gray an image. This function also exists due for a special Isotherm Mode that displays an 
isotherm in a applied palette.  

Display All Objects
This functions causes an objects placed on the image to not display, or become invisible.  

How to . .
Select an object (see chapter on selecting objects) and then Right Click the mouse button 
on the object. Then CLICK on Visible to remove a check mark next to it WHILE THE 
OBJECT IS SELECTED.  If there is no CHECK MARK the object is FLAGED. Note this 
must be done while the object is selected. In the Speed Menu shown to the left Visible has 
a check mark next to it. 

No check mark means the object can be made invisible with use of Show All Objects. 

Then open the Display menu and CLICK on Show All Objects. The object will not be dis-
played. CLICK on Show All Objects and it will display. 

Smooth Image
This alters ONLY the displayed image NOT THE TEMPERATURE DATA.

The software enlarges an image from camera size it interpolates digital values which creates jagged edges. This func-
tion interpolates values and smooths the image for a better appearance. 



Display Isotherms

Click on this function to NOT DISPLAY a Isotherm that is CURRENTLY DISPLAYED. This removes the check 
mark next to that item.  CLICK again to display the Isotherm 

Isotherms
An Isotherm uses the Color Bar part of the Colar Bar Tool to:

1. Display the Isotherm.
2. To create a Isotherm.
3. To adjust a Isotherms.
4. To place multiple Isotherms.

Single Isotherm with
Span  of 8 degrees and
Isotherm Mid-point of
660 degrees.

CLICK anywhere on
this to obtain this
SPEED MENU

SLIDERS for
Span and
Midpoint

Edit - enter
values

Select value
of Isotherm
with
Windows
color control

DOUBLE CLICK to
Select  - then
ISOTHERM shown in
3D.

PLACE Mouse Cursor
anywhere on Isotherm
to get this - HOLD
DOWN LEFT Mouse
button and DRAG
Isotherm to new place
if REQUIRED.

PLACE Mouse Cursor
on TOP or BOTTOM
Edges of Isotherm to
get this - HOLD DOWN
LEFT Mouse button
and DRAG Isotherm to
new size.

CLICK anywhere on
this to obtain this
SPEED MENU
CLICK Add Isotherm
for an Isotherm



NOTE: Clicking on Isotherm will make visible the COLOR BAR TOOL if it is not displayed.

See the illustration at the end of this chapter which shows the various mouse clicks that can be used to manage iso-
therms. Isotherms are powerful tools for analysis of thermal data and require some study of the various tools to use 
properly. f
Attributes of the software’s Isotherm function -

1. Fully editable with the software editing tools.
2. Set isotherms in all the available Windows colors.
3. No limit on the number of Isotherms.
4. Palette Mode - Isotherms display the loaded palette.

Isotherm Speed Menu
CLICK on Isotherms to display the sub-menu shown to the right. Alternatively place the 
mouse cursor on the COLOR BAR TOOL and Right Click the Mouse to show the same menu.  

This menu provides ALL the functions to manage isotherms.

An isotherm must be selected by CLICKING on it before any of the following functions 
can be applied ot it.   

Add Isotherm -
CLICK to place an ISOTHERM on the Color Bar Tool.  Alternatively CLICK on the Isotherm Tool on the Tool Bar.  

The initial color of the Isotherm is that of annotation color set in Annotation Page of preferences.  Default is a solid 
color ISOTHERM 

Please note that successive creation of isotherms places them in the identical place on the color, or replaces one kind 
of isotherm on top of another - which could make a user think the desired action has not taken place.

Set Color
Displays the Standard Windows Color Control.  Use this to select any of the 
colors displayed.

Solid Color 
There are two Isotherm color modes. 

Solid mode color. 
If a solid color is applied to a Isotherm - that color is applied regardless of the 
Isotherms position.  It is always THAT SET COLOR. 
Use the set color to change the colors of isotherms.
Palette Mode color
CLICK on Gray Color FIRST in the Display Menu.  This turns color. The 
palette is function in the background, but the image appears to be gray. 
CLICK on this function to display Isotherms in the existing color palette. The 
color of the isotherm then depends on the position it occupies on the color bar 
- for example if 100 degrees is associated with blue and 200 degrees is  yel-
low, the Isotherm will display yellow if is located at 200 degrees, and blue at 
100 degrees. 

NOTE: Gray Color must be checked in the Display Menu for this function to 
work as described. 



Adjust Isotherm
An Isotherm is an object and as such it can be edited by selection, so that its span and Mid Point (position on the color 
bar) can be changed.
See the illustration on how to do all this several sections back. Note that AGAIN - the speed menu you need to access 
this function is reached by placing the mouse cursor on the Isotherm and right clicking the mouse button.

Delete Isotherm
CLICK on this to delete the SELECTED ISOTHERM.  Alternatively use the Edit menu to Remove the last one, or 
remove all.

Set Scene Emissivity
Enter emissivity values in the EDIT WINDOW in the control shown below. These entered values must be  >0 and 
<=1.

                                                                                                                      
The values entered and applied affects the entire image.  

If a value other than the values permitted are entered the soft-
ware will prompt the user to adjust the entry by display the 
screen below.

Set Scene Transmission 

Set a transmission factor that MAKES the software compensate for infrared interference.  
Scene transmission can be best explained by the following diagram.

Infrared source

Silicon window with 68 %
transmission ( assume all other
loss is 0).

Software reports correct
temperature when a
.68 SCENE TRANSMISSION is
ENTERED



Apply Scene Transmission by entering in the desired value in the pop up dialog box shown below. 

These entered values must be  >0 and <=1.  If they are not the user will be prompted to enter the correct range of val-
ues must be entered. 

Set Ambient Temperature

CLICK on Set Ambient Temp to display the dialog box shown above.  Enter the ambient temperature that surrounds 
the thermal image being display in the Frame Grabber module in the ENTRY BOX - shown above with a 22.  The 
user needs to be aware of the temperature scale set in preferences and the camera such as K, C, and F. 

The value entered is used in the CURRENTLY ACTIVE Module - for example Image Editor, Frame Grabber, etc.

Show All Objects
This OVER-RIDES ALL the setting of the Visible Function that applies to ONE OBJECT.  found in the Properties 
Menu. 

This is a quick way of making all objects such as temperature annotations visible so that they can be edited.



Image Subtraction
Image Subtraction displays the results of an 
Image Subtraction. The subtracted image is 
LOCATED ONLY in the Image Editor.
How to . . .
CLICK on Image Subtraction to display the 
POP OUT menu shown to the right.  

Apply
A check mark next to Apply indicates that the 
results of a subtraction is displayed.  CLICK 
to remove the CHECK to see the image befor 
subtraction was applied.

Set Tolerance
Set tolerance is in actuality a threshold level.

There are two ways in which tolerance is 
applied:

3. Show similarities between sub-
tracted images.Tolerance is the pixel 
digital value between the two 
images that will NOT cause an 
Image Subtraction. 

4. Show differences between sub-
tracted images. Tolerance is the 
pixel digital value between two 
images that WILL CAUSE an Image 
Subtraction.

Show Difference 
Display the difference between two images.
Show Similarity
Display the similarities between two images.

5

              8

    20

7

              20

    90

Image in
Image Editor

Stored Image

Case  5 subtracted from 7  - with a tolerance of 5
subtraction  does or does not take place because the
differences are not large enough.
Case of 8 subtracted from 20 - with a tolerance of 30
subtraction does or does not take place since the
differences are not
Large enough.
Case  20 subtracted from 90 - with a tolerance of 30
subtraction does or does not  take place since the
differences are large enough.



Image Subtraction





Introduction
There exists in this software a set of tool bars that have no corresponding menu functions.  This means that the func-
tions found in these tool bars can be accessed and used ONLY when the tool bar is visible.  In some cases a prefatory 
menu functions must be accessed and used before that tools bar becomes available for use.

Location
These tool bars could be accessed or displayed in any of the software modules though there is no use for some of 
them in certain modules.  Further, the functions of these toolbars if there is no use for them in a particular module will 
be fully grayed or partially grayed and be unavailable for use. 

The software defaults to a set of tool bars that the designers of this software thought were relevent to each module. 
The user is free to make changes.

Related Topics 
Chapter 23 - Setting up, displaying,  and modifying the tool bars. 

The Special Tool Bars
Note that the tool bars all have a TOOL TIP.  Place the mouse cursor (don’t click any buttons) and a tool tip will pop 
up. This will quickly identify the function of the tool under the mouse cursor.

The Replay Tool

Introduction
The REPLAY TOOL allows the user to PERFORM all the functions of a VCR on a series of images that were saved 
in FAST SAVE.  Those images can be compared to what is stored on a VCR tape. 

How to use the Replay Tool Bar
We use the word frames interchangeably with an image in these cases.  Frames are individual images  the camera 
sends to the software for saving in a movie.

This tool only works when the REAL TIME MODULE is LIVE on the SCREEN.  It is NOT necessary to have a con-
nection to a VIDEO SOURCE and have a series of LIVE IMAGES displaying on the screen. A series of images must 
of course be saved prior to using this tool with the Fast Save Function. 

To use load the file which is saved with a MOV extension.  This will display a replay window, showing the previously 
saved frames.  The Replay Tool Bar controls the images or frames displayed on that screen. 

Movie Save
Refer to the information in Chapter 5 The Events Menu for information on using the Fast Save Function.  There is 
also information on creating a special ROI (region of interest) if the entire image is not wanted. 



Once a series of frames are captured. The buttons on the Fast Save tool becomes ungrayed and available for use.

To use - CLICK the LEFT MOUSE BUTTON on each function in the tool. 

The functions of the tool bar

Rewind 
Move backward through the image frames to the FIRST IMAGE and display this IMAGE. The button then become 
gray.

Step Back - 1 frame
CLICK on this BUTTON to view the PREVIOUS IMAGE (1 frame back). Each CLICK of the MOUSE moves back 
1 frame through the entire series of frames in the movie. 

Fast playbackward
Step through the series of images as fast as frame of the camera and computer permits - BACKWARD.

Stop
Halt action initiated by PLAY forward or backward.  This is a freeze frame.

Slow playforward
View the images at 2 frames per second rate. This enables you to see fast action in slow motion. 

Rewind to 
beginning 

Step back - 1 
frame per click 

Fast play backward STOP play 

Slow play forward 

Fast play forward 

Step forward  - 1 frame per click 

Rewind to END 

Mark frames 

Delete marked 
frames 

Play tools 

Edit  



Step Forward - 1 Frame
Step forward 1 frame with each CLICK of the mouse button. 

Play tools
This tool will display a dialog box shown to the right that lets 
you control how fast frames are displayed in slow play for-
ward or backward. 

This tool is a configure slow play control. 

You can adjust the time between frames in milliseconds, or the 
number of frames per second. 

This tool makes it possible to view events occuring at very 
high speeds in very slow motion. 

Edit
This tool displays a window containing one frame. This makes it possible to treat a frame that is normally displayed 
as a series of images as a single image so that it can be saved in any of the supported file formats.

Mark
This tools lets you mark a number of frames for deletion. It is not necessary that they be contiguous frames. Marked 

areas are shown in the RED bar at the bottom of the replay window shown above. This provides a visual representa-
tion to the viewer of where the marked sections are with relation to the ends of the frames series.

Cut
Remove from the series of frames ALL MARKED FRAMES.

Info Bar
This information tool contains basic information that the user refers to why performing image analysis.

Refer to Chapter 8 Frame Grabber Menu for information on the functions that affect this tool bar.

Emiss refers to SCENE EMISSIVITY. Trans refers to SCENE TRANSMISSION. Ambient refers to the AMBIENT 
TEMPERATURE surrounding the thermal image. Palette is the name of the palette used to colorize the image. 



Color Bar
The color bar is not a part of the IMAGE as in previous 16 bit software packages. It is a TOOL BAR and has FUNC-
TIONS and important functions associated with its capabilities to display the COLOR and TEMPERATURE of the 
selected THERMAL IMAGE. 

When a calibrated image is saved and then reloaded. All the information associated with it is displayed on the color 
bar.

Level/Sens Tool
This tool is used to control the IMAGE temperature displayed. That can be in K, C, F or Digital Values. 

The SPAN or the top and bottom is supplied by the support camera. 

NOTE: Dragging or moving the SPAN MARKER to the extreme top (in the example below - above 100) will display 
in RED 103. The same is true of the extreme bottom. This is NORMAL.

How to use...
To move the entire SPAN MARKER up or down place the mouse on the marker and CLICK the mouse and drag to a 
new position.

Change the size of the SPAN MARKER by using either the buttons on the top and bottom of the control (- -, -, +, ++)
until the desired size is achieved.

Upper and Lower
temperature markers

Temperature Span
Marker with TOP and
BOTTOM marker.
CLICK and DRAG these
to new positions

Range of temperature
Between BOTTOM
and TOP

Temperature Scale

Speed Buttons to
Adjust
SPAN MARKER.
++ L t

Speed Buttons to
Adjust
SPAN MARKER.
++ L t



Software Conditions

The software is supplied with a REMOTE with NUMBERS 0 through 9.  CLICKING on the NUMBERS below has 
the same effect as PUSHING on the CORRESPONDING BUTTONS on the REMOTE.

This TOOL is largely for the user’s convenience.





The Object Menu
Location
Frame Grabber Module and Image Editor.

The following functions are found in the Object 
Menu  

1. Point temperature
2. Spot Temperature
3. Line Temperature
4. Rectangle Temperature
5. Shape Temperature
6. Circle Temperature
7. Text Annotation
8. Line Annotation
9. Rectangle Annotation
10. Shape Annotation
11. Circle Annotation
12. Rectangle Exclusion
13. Shape Exclusion
14. Circle Exclusion
15. Freehand Shape Exclusion
16. Assign Labels
17. Emissivity Adjust
18. Temperature Adjust

Special useability features
NOTE: to help the user in locating the temperature point, mouse tem-
perature should be turned on in preference.  What this does is to dis-
play the temperature under the mouse cursor. 
The following is true of an IRRIS 256 camera
In the illustration shown below the STATUS BAR shows the MOUSE CURSOR location in X and Y pixel locations. 
For example the upper left hand corner of a LIVE IMAGE would be X=0 and y= 0. The lower right hand corner 
would be x=254 and y = 254. If the image is expanded full size - to fill the entire screen irrespective of screen resolu-
tion - 640 by 480 even 1600 x 1200, this would still be true since we are showing pixel location.

A ZOOMED image will also show this but in a different manner. For example a ZOOM of location at x = 254 and 
254 would show the entire image as z = 254 and y = 254 at any cursor location. 
True of all cameras
Turning on Mouse Temperature in PREFERENCE SETUP will display the temperature under the mouse cursor as 
shown below.  Images can have WHITE TOP HOT pizels originating with noise, which will give false readings.  Spot 
which has the same function as POINT will average this out.  



To turn mouse temperature on, set on by default,  CLICK on FILE, CLICK on PREFERENCE, and THEN CLICK on 
SETUP TAB. 

Related Tool Bars 

Related topics
These should be reviewed studied prior to applying menu items. Example - editing, selecting, temperature objects, 
even the concept of an object is very important to a sound application of the functions in this menu.

1. Editing objects chapter 4.
2. Using the mouse chapter 4. 
3. Speed menus chapter 4
4. preferences chapter 4
5. Edit menu.   

The object menu is shown to the right. Emissivity and Temperature Adjust are GRAYED in the Frame Grabber mod-
ule, but become available (not grayed) in the image editor. 

Introduction to the Object Menu
An object is anything overlayed on an image, which is why this is called an object menu.

The Object Menu has 4 groups of functions. 

1. temperature measurement tools
2. text
3. shapes
4. an assorment related to temperature - labels, and emissivity and temperature adjustments.

The material on temperature tools and how to use them requires careful study to apply. This is also true if the user 
wants to use more than than just POINTS, and LINES, sincere there are other useful tools such as SPOT, ELIPSE/
CIRCLE, and above all SHAPE. 

Object Menu Functions
Point Temperature
Point Temperature extracts the temperature value of a single pixel of a temperature calibrated image. There is no lim-
itation on the number these points that can be placed on the screen.



Point temperature illustration. 

Point Temperature - marked with a +, and is the exact location of the temperature extraction.
Leader - LINE pointing to the temperature value and label.
Label - text describing the temperature extraction, in this case a POINT and POINT NUMBER 3.
Temperature value - extracted temperature value of the point.

How to use Point Temperature Object  -

1. CLICK on the Point Icon or CLICK on the Object Menu and then CLICK on Point Temp.  
2. The Mouse Cursor will change to a +. Notice that the STATUS BAR displays Point Temp.  Until another 

software function is selected - the software remains in this function.  
3. Move this + to the place on the image where a point temperature object is desired. The temperature under the 

mouse cursor is placed on the status bar, which should help in located the desired temperature.
4. CLICK AND HOLD DOWN the LEFT MOUSE BUTTON.  Then while continuing to HOLD DOWN THE 

MOUSE BUTTON, move the mouse to place the leader.
5. When in the desired location RELEASE THE LEFT MOUSE BUTTON.  A label and temperature value will 

be placed at the END OF THE LEADER.
6. The point temperature now is in an EDITABLE CONDITION as indicated by the RECTANGLES at both 

ends of the leader. Every edit function of this software can be applied NOW EXCEPT the ability to MOVE 
the TEMPERATURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point 
Temperature extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the 
items in the Speed Menu, and the keyboard functions can be applied.  IT REMAINS EDITABLE until 
Point Temperature is de-selected, or another tempeature extraction is done.

The software user should review the chapter on Editing in this manual. 

Spot Temperature
Spot Temperature extracts the average temperature value of a 3X3 array of pixels (a 9 pixel area). There is no limita-
tion on the number of  Spot objects that can be placed on the screen.

Point
Temperature

Leader

Label

temperature
value



Spot Temperature - marked with a +, and is the exact location of the temperature extraction.
Leader - LINE pointing to the temperature value and label.
Label - text describing the temperature extraction, in this case a POINT and POINT NUMBER 3.
Temperature value - extracted temperature value of the point.

How to use Spot Temperature Object  -
1. CLICK on the Spot Icon or CLICK on the Object Menu and then CLICK on Spot Temp.  
2. The Mouse Cursor will change to a +. Notice that the STATUS BAR displays Spot Temp.  Until another 

software function is selected - the software remains in this function.  
3. Move this + to the place on the image where a spot temperature object is desired. The temperature under the 

mouse cursor is placed on the status bar, to locate the desired temperature.
4. CLICK AND HOLD DOWN the LEFT MOUSE BUTTON.  Then while continuing to HOLD DOWN THE 

MOUSE BUTTON, move the mouse to place the leader.
5. When in the desired location RELEASE THE LEFT MOUSE BUTTON.  A label and temperature value will 

be placed at the END OF THE LEADER.
6. The spot temperature is now EDITABLE as indicated by the RECTANGLES at both ends of the leader. 

Every edit function of this software can be applied NOW EXCEPT the ability to MOVE the TEMPERA-
TURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point Temperature 
extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the items in the Speed 
Menu, and the keyboard functions can be applied.  IT REMAINS EDITABLE until Point Temperature is 
de-selected, or another tempeature extraction is done.

The software user should review the chapter on Editing in this manual. 

Spot
Temperature

Leader

Label

temperature
value



Line Temperature
Line temperature takes the 
value of each pixel along a 
line and takes the average, 
minimum, and maximum 
of those pixels. There is no 
limitation on line length or 
the number of lines that can 
be annotated.

Lines can be graphed at the 
end of a leader as shown 
below, or displayed as a 
MIN, MAX, and AVG 
value as shown below.  
These options can be exer-
cised by RIGHT CLICK-
ING the Mouse when Line 
is SELECTED, and 
CLICKING on Graph in 
the displayed SPEED 
MENU.  This graph has 
nothing to do with the 
graph module accessed in 
the Report Menu.  

How to use Line Temperature Object  -
1. CLICK on the Line Icon or CLICK on the Object Menu and then CLICK on Line Temp.  
2. The Mouse Cursor will change to a +. Notice that the STATUS BAR displays Line Temp.  Until another 

software function is selected - the software remains in this function.  
3. Move this + to the place on the image where the beginning of the Line temperature object is desired. The 

beginning can be either the LEFT or RIGHT OF THE LINE. The temperature under the mouse cursor is 
placed on the status bar, which should help in located the desired temperature.

4. CLICK AND HOLD DOWN the LEFT MOUSE BUTTON.  Then while continuing to HOLD DOWN THE 
MOUSE BUTTON, move the mouse to place the LINE.

5. When in the desired location RELEASE THE LEFT MOUSE BUTTON. And CLICK the LEFT MOUSE 
BUTTON AGAIN and then while continuing to HOLD DOWN THE MOUSE BUTTON, move the mouse 
to place a leader. When the leader is placed in the desired position and length RELEASE the MOUSE BUT-
TON to ANCHOR.  label and temperature annotation is then placed at the END OF THE LEADER.

6. The Lead Temperature Object is EDITABLE as indicated by the RECTANGLES at both ends of the object.  
Every edit function of this software can be applied NOW EXCEPT the ability to MOVE the TEMPERA-
TURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point Temperature 
extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the items in the Speed 
Menu, and the keyboard functions can be applied.  The Line Temperature Object  REMAINS EDITABLE 
until Line Temperature is de-selected, or another tempeature extraction is done.

Related topics
CLICK on Report, and CLICK on Graph to access the Graph Module to graph a Line Temperature Object.  Review 
Chapter 5 on the Event Manager to see how this temperature object is used in the event manager. 
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Rectangle Temperature

Rectangle temperature object takes the average, minimum, and maximum values of all the pixels with the boundries 
of that rectangle. There is no limitation on the number of these that can be taken on one image. 

Rectangle objects can be mini graphed as a histogram placed at the end of a leader as shown below, or displayed as a 
MIN, MAX, and AVG value as also shown below.  These options can be exercised by RIGHT CLICKING the Mouse 
when Rectangle is SELECTED, and CLICKING on Graph in the displayed SPEED MENU.  This graph has nothing 
to do with the graph module accessed in the Report Menu.  

How to use Rectangle Temperature Object  -
1. CLICK on the Rectangle Icon or CLICK on the Object Menu and then CLICK on Rectangle Temp.  
2. The Mouse Cursor will change to a +. Notice that the STATUS BAR displays Rectangle Temp.  Until 

another software function is selected - the software remains in this function.  
3. Move this + to the corner of the planned rectangle object from which the leader will emerge. Refer to the 

illustrations above, to see how the leader emerges from one of the 4 corners.   The temperature under the 
mouse cursor is placed on the status bar, which should help in locating the desired temperature. X and Y 
coordinates are also supplied as an aide to the location of successive temperature objects. 

4. CLICK AND HOLD DOWN the LEFT MOUSE BUTTON.  Then while continuing to HOLD DOWN THE 
MOUSE BUTTON, move the mouse to the right or left and up or down to form and place the RECTAN-
GLE..

5. When the desired shape is obtained  RELEASE THE LEFT MOUSE BUTTON. Move the  MOUSE BUT-
TON AGAIN to locate and form the LEADER.  When the leader is placed in the desired position and length 
RELEASE the MOUSE BUTTON to ANCHOR.  label and temperature annotation are then placed at the 
END OF THE LEADER.

6. The Lead Temperature Object is now EDITABLE as indicated by the RECTANGLES at the corners of the 
rectangle. Every edit function of this software can be applied NOW EXCEPT the ability to MOVE the 
TEMPERATURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point 
Temperature extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the 
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items in the Speed Menu, and the keyboard functions can be applied.  The Rectangle Temperature Object 
REMAINS EDITABLE until Rectangle Temperature is de-selected, or another tempeature extraction 
is done.

Related topics
CLICK on Report, and CLICK on Graph to access the Graph Module to graph a Rectangle Temperature Object.  
Review Chapter 5 on the Event Manager to see how this temperature object is used in the event manager. 

Shape Temperature

Shape Temperature object takes the average, minimum, and maximum values of all the pixels with the boundries of 
that shape. Shape is drawn with a series of segments that enclose a geometric area. There is no limitation on the num-
ber of segments or on the number of shapes that can be taken on one image. 

Shape objects can be mini graphed as a histogram placed at the end of a leader as shown below, or displayed as a 
MIN, MAX, and AVG value as also shown below.  These options can be exercised by RIGHT CLICKING the Mouse 
when Shape is SELECTED, and CLICKING on Graph in the displayed SPEED MENU.  This graph has nothing to 
do with the graph module accessed in the Report Menu.  

How to use Shape Temperature Object  -
1.CLICK on the Shape Icon or CLICK on the Object 
Menu and then CLICK on Shape Temperature.  
2.The Mouse Cursor will change to a +. Notice that 
the STATUS BAR displays Shape Temperature.  
Until another software function is selected - the soft-
ware remains in this function.  
3.Move this + to the FIRST SEGMENT of the 
planned SHAPE OBJECT object from which the 
leader will emerge. Refer to the illustrations above, 
to see how the leader emerges from a FIRST SEG-
MENT  The Temperature under the mouse cursor is 
placed on the status bar, which should help in locat-

ing the desired temperature. X and Y coordinates are also supplied as an aide to the location of successive 
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temperature objects. 
4. CLICK the LEFT MOUSE BUTTON.  Then  move the mouse to draw a line to the next segment location 

and CLICK the Mouse, to place a segment.  Continue to due this until the entire shape except for the last line 
to enclose totally the shape is done.  Then DOUBLE CLICK THE LEFT MOUSE BUTTON and the 
SHAPE will enclosed itself, by finishing the last line. 

5. Move the  MOUSE BUTTON AGAIN to locate and form the LEADER. When the leader is placed in the 
desired position and length CLICK the  MOUSE BUTTON to ANCHOR.  label and temperature annotation 
are then placed at the END OF THE LEADER.

6. The Lead Temperature Object is now EDITABLE as indicated by the RECTANGLES at the corners of the 
rectangle. Every edit function of this software can be applied NOW EXCEPT the ability to MOVE the 
TEMPERATURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point 
Temperature extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the 
items in the Speed Menu, and the keyboard functions can be applied.  The Shape Temperature Object  
REMAINS EDITABLE until Shape Temperature is deselected, or another tempeature extraction is 
done.

Related topics
CLICK on Report, and CLICK on Graph to access the Graph Module to graph a Shape Temperature Object.  Review 
Chapter 5 on the Event Manager to see how this temperature object is used in the event manager.  

Circle Elipse Temperature 
Circle Temperature object takes the average, minimum, and maximum values of all the pixels with the boundries of 
that shape. Shape is drawn with a series of segments that enclose a geometric area. There is no limitation on the num-
ber of segments or on the number of shapes that can be taken on one image. 

Shape objects can be mini graphed as a histogram placed at the end of a leader as shown below, or displayed as a 
MIN, MAX, and AVG value as also shown below.  These options can be exercised by RIGHT CLICKING the Mouse 
when Shape is SELECTED, and CLICKING on Graph in the displayed SPEED MENU.  This graph has nothing to 
do with the graph module accessed in the Report Menu.  

How to use Circle Temperature Object  -



1. CLICK on the Circle Icon or 
CLICK on the Object Menu and 
then CLICK on Circle Tempera-
ture.  

2. The Mouse Cursor will change to 
a +. Notice that the STATUS BAR 
displays Circle Temperature.  
Until another software function is 
selected - the software remains in 
this function.  

3. Move this + to center of  the 
planned CIRCLE OBJECT object. 
The Temperature under the mouse 
cursor is placed on the status bar, 
which should help in locating the 
desired temperature. X and Y 
coordinates are also supplied as an 
aide to the location of successive 
temperature objects. 

4. CLICK the LEFT MOUSE BUT-
TON. WHILE HOLDING 
DOWN THE MOUSE BUTTON  
move the mouse to draw a CIR-
CLE OR ELIPSE. CLICK the 
Mouse to anchor and finish the circle. 

5. Move the  MOUSE BUTTON AGAIN to locate and place a leader LEADER. A circle allows the user to 
drag the leader around the circumferance of the circle. When the leader is placed in the desired position and 
length CLICK the  MOUSE BUTTON to ANCHOR.  label and temperature annotation are then placed at the 
END OF THE LEADER.

6. The Lead Temperature Object is now EDITABLE as indicated by the RECTANGLES at the corners of the 
rectangle. Every edit function of this software can be applied NOW EXCEPT the ability to MOVE the 
TEMPERATURE OBJECT. If the right button is NOW CLICKED a SPEED MENU relating to the Point 
Temperature extraction now displays. Any of the active ICONS, anything in the Ribbon Bar, any of the 
items in the Speed Menu, and the keyboard functions can be applied.  The Circle Temperature Object  
REMAINS EDITABLE until Circle Temperature is de-selected, or another tempeature extraction is 
done.

Related topics
CLICK on Report, and CLICK on Graph to access the Graph Module to graph a Circle Temperature Object.  Review 
Chapter 5 on the Event Manager to see how this temperature object is used in the event manager.  
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Text
Text uses a method called RICH TEXT to 
annotate text on LIVE Images, in the Image 
Editor, or a Template.

Please exuse the text subject.  It is intended 
only to illustrate the text functions available 
to the software user.

This function permits SCROLLING, WRAP 
WRAP, AND APPLICATION OF ALL THE 
WINDOWS FONT ATTRIBUTE. Rich text 
permits any of the normal keyboard functions 
associated with writing text except TABS.

A transparent text box with a border is shown 
to the left. 

A text box is shown below that.  Note that its 
color is different.  It also has a border placed 
around it.

NOTE: before working through the procedure 
below UNDERSTAND the Properties Menu 
functions that relate to text. This is especially 
true of theTRANSPARENT function, since it 
can appear to cause BACKGROUND to fail. 
 
How to . . .
Follow these THREE STEPS:
To place new text on the screen.  CLICK on 
the ABC tool.  The mouse turns INTO A 
RAIL.  Place this RAIL on the UPPER LEFT 
HAND corner of the text box that is going to 
be drawn. DRAG a RECTANGLE to the 
required size.  It can be edited to a new shape 
or size later. Then place the RAIL CURSOR 
in the upper left hand corner and begin to type 
text. NOTE: the user could have a perfectly 
natural inclicnation to note the rail cursor and 
then attempt to begin writing text. 
To edit text. Move the mouse cursor OUT 
OF THE TEXT BOX or into the adjacent area. CLICK the Mouse.  The speed menu shown to the left will display.  
CLICK on Edit. This will restore the RAIL CURSOR.  Place the rail cursor in the text box and perform any keyboard 
edit function normal to windows. 
To change the size or shape of the text box. Any time edit text has been clicked or anytime the user moves the 
mouse cursor off the text box and clicks the border of the text box can be RESHAPED. Text existing in the box 
will FLOW to the new shape with PERFECT WORD WRAPPING.



Arrow draw
CLICK on Object and then CLICK on Arrow access the arrow draw function.  The status bar says Arrow Annot and 
the software remains in this function until a new function is selected or a new object is selected. 

Arrow is a fully editable object.

How to use . . .
CLICK to place on the arrow tip on the screen, then while holding down the mouse button drag the arrow body to any 
desired position and length.  Note movement of the mouse rotates the arrow around the tip.

The arrow is placed as an editable object when first placed until deselected.

CLICK the Right Mouse Button to access a SPEED MENU with functions that can be used to edit the arrow.

Line Draw
Line draw functions identically to Arrow draw.

Rectangle Draw 
CLICK on RECTANGLE TOOL or CLICK on OBJECT and then CLICK on Rectangle to access this function. The 
status bar says Rectangle Annot and the software remains in this function until a new function is selected or a new 
object is selected.

Rectangle is a fully editable object.

How to use . . .
CLICK the Mouse on the Screen where the upper left hand corner of the rectangle is to be placed.  Then while hold-
ing down the button drag the rectangle to the size and position desired.

The Rectangle is placed as an editable object when first placed until deselected. 

CLICK the Right Mouse Button to access a SPEED MENU with functions that can be used to edit the new rectangle.

Circle/Elipse Draw 
CLICK on CIRCLE TOOL or CLICK on OBJECT and then CLICK on CIRCLE to access this function. The status 
bar says Circle  Annot and the software remains in this function until a new function is selected or a new object is 
selected.

Circle/Elipse is a fully editable object.

How to use . . .
CLICK the Mouse on the Screen where the CENTER OF THE CIRCLE OR ELIPSE WOULD BE PLACED. Then 
while holding down the button drag the circle/elipse to the size and position desired.

The CIRCLE is placed as an editable object when first placed until deselected. 

CLICK the Right Mouse Button to access a SPEED MENU with functions that can be used to edit the new circle. 



Shape Draw 
CLICK on SHAPE TOOL or CLICK on OBJECT and then CLICK on SHAPE  to access this function. The status bar 
says Circle  Annot and the software remains in this function until a new function is selected or a new object is 
selected.

Shape is a editable object.

How to use . . .

CLICK the Mouse on the Screen to place the beginning of  the FIRST SEGMENT of the planned SHAPE OBJECT 
object.  Refer to the illustrations on Shape Temperature above, to see how a shape is drawing with SEGMENTS.   
Move the mouse to draw a line to the next segment location and CLICK the Mouse, to place a segment.  Continue to 
due this until the entire shape except for the last line to enclose totally the shape.  Then DOUBLE CLICK THE LEFT 
MOUSE BUTTON and the SHAPE will enclosed itself, by finishing the last line.  

Shape takes some practice to do proficiently - but there is no other way to annotate irregular areas of interest on an 
image. There is no limit on the number of segments. 

Shape is placed as an editable object when first placed until deselected. 

CLICK the Right Mouse Button to access a SPEED MENU with functions that can be used to edit the new shape.

Rectangle Exclusion

The uses of Rectangle Exclusion
Frequently there is a need to exclude an area inside of a temperature object from being read by the temperature object.
And example would be a area of text generated by the camera that would read WHITE TOP OF THE TEMPERA-
TURE scale and render the readings of the temperature object useless.  
How to
Draw a rectangle as in the methods showen in previous sections to this one. The area of the rectangle object will show 
as a CROSS HATCHED area.  That area is EXCLUDED from temperature extraction or measurement. 

An exclusion object ONLY TAKES effect inside a RECTANGLE, SHAPE, CIRCLE temperature object.  It will not 
work when placed over a POINT, SPOT, or LINE.

Shape Exclusion

The uses of Shape Exclusion
Frequently there is a need to exclude an area inside of a temperature object from being read by the temperature object.
And example would be a area of text generated by the camera that would read WHITE TOP OF THE TEMPERA-
TURE scale and render the readings of the temperature object useless.  Shape Exclusion allows the user to enclose an 
area by SEGMENTED LINES. 
How to
Draw a shape as in the methods showen above. The area of the shape object will show as a CROSS HATCHED area.  
That area is EXCLUDED from temperature extraction or measurement. 

An exclusion object ONLY TAKES effect inside a RECTANGLE, SHAPE, CIRCLE temperature object.  It will not 
work when placed over a POINT, SPOT, or LINE.



Circle Exclusion

The uses of Circle Exclusion
Frequently there is a need to exclude an area inside of a temperature object from being read by the temperature object.
And example would be a area of text generated by the camera that would read WHITE TOP OF THE TEMPERA-
TURE scale and render the readings of the temperature object useless.  Circle Exclusion allows the user to enclose an 
area with a circle or elipse. 
How to
Draw a circle as in the methods showen above. That area of the circle or elipse is excluded from temperature extrac-
tion or measurement.

An exclusion object ONLY TAKES effect inside a RECTANGLE, SHAPE, CIRCLE temperature object.  It will not 
work when placed over a POINT, SPOT, or LINE.
 

Freehand Shape Exclusion

The uses of Freehand Shape Exclusion
Frequently there is a need to exclude an area inside of a temperature object from being read by the temperature object.
And example would be a area of text generated by the camera that would read WHITE TOP OF THE TEMPERA-
TURE scale and render the readings of the temperature object useless.  Freehand shape allows the user to enclose 
objects that would not be convenient with other shape exclusion objects. 
How to
Freehand Shape is unique and has no similarity to other annotations. To 
use - CLICK on the function.  The mouse cursor will then change into a 
+. Place that + where it is desired to begin the Freehand Shape. While 
holding down the LEFT MOUSE BUTTON move or DRAG the mouse 
to describe the shape. Draw a circle as in the methods showen above. 
That area of the shape is excluded from a temperature extraction or mea-
surement. 

An exclusion object ONLY TAKES effect inside a RECTANGLE, SHAPE, CIRCLE temperature object.  It will not 
work when placed over a POINT, SPOT, or LINE.

What you can’t do with Freehand Shape Exclusion
The user is ONLY able to select the object and move it by draging and droping with the mouse.  It is not possible to 
change the shape of object.  To change the object - the user will have to SELECT and then DELETE the object, and 
then draw a new object. 

 Assign Labels
A label is the identification that the software uses to distinquish each temperature object.  Example Point 1, Point 2, 
or Line 5, or Line 10. Labels are automatically annotated on the image when a temperature object is used.  There are 
two components to a label - INDEX a numerical number, and Text such as Point, Reference, Fault, Phase 3, etc.  
Refer to the illustrations used in the temperature objects, such as Point, Line, Shape, etc. The software user must 
understand the topic of Index to effective use Labels. 

A default label of Point, Line, etc is ALWAYS loaded.  There is no 

The setting of the Image Tab in Preference located in the File Menu loads a default label menu each time the software 
loads.  Check this by CLICKING on File, CLICKING on Preference, and CLICKING on Image. 
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Use this control to make new labels, edit them, save them, load them, etc. 

How to use . . . 

Label - use this to enter a new label by CLICKING  on Add and then typing in not more than 45 alphnumeric charac-
ters. Or when a label is selected as in the illustration above, CLICK on Modify to edit the label.

Type -  use this List Control to select any of the temperature object such as Point, Line, Rectangle, Circle, Spot, and 
Shape.

Index - Assign a difference index number for each temperature object of the same kind.  For example a series of  
POINTS would be labeled 1, 2, 3, etc., successively. A line or any other temperature object could have the same 
series of numbers.

Save - When done CLICK on Save to save any work done.

OK - Click on OK is it is desired to USE a new or changed label but not save it.

Load - CLICK on Load to load a Label file. 

Emissivity Adjust
The emissivity adjust function allows the user to place a ROI in the form of a rectangle on the screen and then select 
or edit an emissivity correction for that ROI.

How to . . .
CLICK on the Object Menu, then CLICK on Emissivity Adjust. The mouse cursor will change into a +.  Place this 

lect from any of the
MPERATURE OBJECTS.

Set the index  for the
selected  temperature
Object.

d - make a new label
odify - edit a label
move - delete a label

Existing label display
with index

OK - accept an ADD or Modify
Cancel - exit without saving
Save - save a Modify or
Load  - load a existing label file.



The Properties Menu
Location
Frame Grabber Module and Image Editor.

The following functions are 
found in the Object Menu  

7. Font
8. Set Color
9. Line Width
10. Minigraph Options
11. Text
12. Fill Shape
13. Show Graph
14. Visible *
15. Set Object Emissivity
16. Celsius
17. Fahrenheit
18. Kelvin
19. Display Order

*NOTE: Visible applies only to the Frame 
Grabber Menu.

Related topics
These should be reviewed when studying any of 
the properties menu items.

6. Editing objects chapter 4.
7. Using the mouse chapter 4. 
8. Speed menus chapter 4
9. Preferences chapter 4
10. Edit menu. 

Related Tool Bars



Introduction to the Properties Menu
The Properties Menu is used to SET ATTRIBUTES FOR A SELECTED OBJECT, which may alter the defaults set in 
preference.  

Object attributes can be made distinctive and unique from other objects to call attention to a particular feature of an 
IR image.  

NOTE: some of the menu items are grayed.  These remain grayed until an object is selected. 

Not all of the objects have the same properties, which means that not all of the functions described in the properties 
menu can be applied.  For example the user is unable to place a border on 

The Functions of the Properties Menu
Font

Font uses a standard Windows font control to set the 
properties of a font.

These font adjustments apply to any objects that uses a 
font.  The exception are the tool bars which includes 
the COLOR BAR.

These adjustments are made ONLY to the selected 
OBJECT.  Preferences font settings are the default set-
tings.  To undo FONT SETTINGS, and revert to the 
default settings,  CLICK on Edit and then CLICK on 
Undo. 

How to use . . .
CLICK on the Properties Menu and then CLICK on 
Font.  The control shown to the left pops up. From 
there set the Font and what font attributes that are 

desired.  

NOTE: Some of the attributes such as color, overlap with other functions and tools. Either can be used since they are 
all fully functional. 

Set Color
Use SET COLOR to set a COLOR for a selected object.  This could overides the color annotations settings in Prefer-
ences for Fill Object. 

These adjustments are made ONLY to the selected OBJECT.  Preferences Color Annotation Settings are the default 
settings.  

To undo SET COLOR ,  CLICK on Edit and then CLICK on Undo. 

How to use . . .
CLICK on the Properties Menu and then CLICK on Set Color.  Then use the color control to select a color, by double 
clicking on a color. 



NOTE: if a object with a border only is selected SET COLOR will apply to that border. If that OBJECT has been 
filled with Fill Object Set COLOR will change the color at ONCE. 
Text

Line Width
These adjustments are made ONLY to a selected OBJECT.  Preferences Color 
Annotation Settings are the default settings.  To undo SET WIDTH ,  CLICK on 
Edit and then CLICK on Undo. 

How to use . . .
CLICK on the Properties Menu and then CLICK on Set Width.  Then use the control 
shown to the RIGHT to set a width.

Current Line Width shows the line width for a SELECTED OBJECT.  Use the UP/DWN buttons to increase or reduce 
a line with.  

To APPLY this setting, CLICK on OK.  Use cancel to exit without changing the line width. 

Minigraph Options
These adjustments are made ONLY to the selected temperature OBJECT with a minigraph or histograph RUNNING.  
Preferences Minigraph Settings are the default settings.  To undo changes to Minigraph Setup,  CLICK on Edit and 
then CLICK on Undo. 

How to use . . .

DATA - Set the color of the 
graph portion of the MINIGRAPH
.
LABELS -Set the color of the Label por-
tion of the MINIGRAPH.

BACKGROUND - Set the color of the 
Background of the MINIGRAPH.

BORDER - Set the color of the border of 
the MINIGRAPH. 

APPLY BACKGROUND - Enable the 
background 

AUTO SCALE TEMPERATURE
CHECK to enable auto set. This means 
that the software finds the maximum and 
minimum temperature values for the 
temperature object and displays those as 
a graph. 
UNCHECK - the user can set values for 
the graph manually. 

Background

Data

Border

Label



Text
This function sets ATTRIBUTES for TEXT. To place TEXT use the text function in the Object Menu.

The user must understand that text when text is being entered is 
ALWAYS NOT TRANSPARENT.  This is done because it is difficult 
to place text directly on the image.  BLACK is the default color used. 
At this time SET BACKGROUND COLOR is  functional and does 
not require TRANSPARENT to be SET FIRST. 
How to . . .
CLICK on TEXT and the SUB MENU shown to the left DISPLAYS.  
The set of three functions apply to a text frame created with the Text in 
the Object Menu.

SET BACKGROUND COLOR
To apply this function initially to a text frame TRANSPARENT 
MUST BE SET FIRST.  

If the text object is ALREADY transparent then function is available 
and will apply without FIRST making the text object transparent. 

Then CLICK on this function to access a WINDOWS COLOR SELECTION DIALOG. From this select the desired 
color. A custom color can also be specified. 

The effect of applying this function is to make the background a SOLID COLOR so that the user cannot see through 
the text box to the underlying image. 

TRANSPARENT 
Follow these steps

5. Create a text frame with TEXT.  
6. Then select that text frame. 
7. CLICK on Transparent - the EYE becomes UNGRAYED 

indicating that the TEXT FRAME is transparent. 

Show Border
By default a border is ALWAYS placed around a TEXT OBJECT.  
This function removes that border.

How to use  . . .
Select the text object.  Then CLICK on Show Border.  If a border 
exists this will remove the border.  If a border did not exist this will 
place a border around a TEXT OBJECT.

Fill Shape
Uses the color applied by SET COLOR or set in Preferences Annota-
tions, to fill an object with a SOLID COLOR. Objects always display 
initially with an OUTLINE.  ALSO - this function fills only objects that HAVE an OUTLINE property. 
How to use . . .
Select the object first.  Then CLICK on the Properties Menu and  CLICK on Fill Shape.  



Alternatively RIGHT CLICK on the selected object to obtain a SPEED MENU such as the one shown ABOVE. 

Show Graph
Displays a LINE GRAPH at the end of the leader on Line temperature objects, and a histogram  at the end of the 
leader for Shape, Rectangle, and Circle. 

How to use . . .
Select the temperature object first,  then CLICK on the Properties Menu and then CLICK on Show Graph. Use mini-
graph setup if the defaults set in preferences need adjustment. 

Visible
This function applies ONLY to the Frame Grabber Module.

The function removes a selected object from view.  Other properties of the object are not changed - for example a 
temperature object will continue to send temperature information to the event manager. 

How to use . . .

This function MUST work in in CONCERT with the Show All Objects func-
tion located in the Image Menu.  For this function to work the Show All 
Objects must have no CHECK MARK.  Only THEN will the VISIBLE 
function become AVAILABLE.  

To use this function use the following 5 steps

7. Insure that Show All Objects is NOT checked. 
8. Select the object.  
9. CLICK on Properties and then CLICK on Visible. 
10. NO check mark in front of the control means has invisible property.
11. Then CLICK off the OBJECT onto the rest of the image.

To make the object visible . . .
Select the object again and then CLICK on Visible to restore the check mark and make 
the selected object visible. 

If it is difficult to find the object made invisible with this function go to the Image 
Menu and CLICK on Show All Objects to REMOVE THE CHECK MARK.  All 
objects made invisible will display. 

Show Graph
This function displays a mini-graph associated with a selected temperature object such 
as LINE, CIRCLE, SHAPE, and RECTANGLE.

This mini-graph provides MIN, MAX, AVG values along with a line graph for line 
temperature objects.  Circle, rectangle, and shapes display a histogram.

A mini-graph’s attributes are set in PREFERENCES.  To depart from this use a speed 
menu as shown below.



How  to . . .
SELECT the temperature object. CLICK on the Properties Menu and then CLICK on Show Graph.

Alternatively SELECT the temperature object and RIGHT CLICK to pop up this SPEED MENU with a set of related 
functions, shown to the RIGHT. 

In this set of functions the user can alter the attributes of a mini-graph from the defaults set in Preferences.  

Set Object Emissivity
This function sets an emissivity value for a SELECTED TEMPERATURE object. 

It does not adjust emissivity for a selected ROI, a function provided by Adjust Emissivity in the Object Menu. 

These adjustments are entered, edited, and saved in a pop up control

How to use . . .

SELECT the temperature object. Then CLICK on Properties Menu and CLICK on Set Object Emissivity.

A dialog box like that shown to the left will pop up.
Enter into description the appropriate description of 
the temperature object to be adjusted. Then enter a 
value of the adjustment >0 and < or = to 1.

NOTE: that the software will HIGH LIGHT the 
description if already placed in the dialog for the 
temperature object selected. 

Temperature Units
This functions provides the ability to change units to 
Celsius, Fahrenheit, or Kelvin on a selected temper-
ature objects. 

All OTHER temperature objects CONTINUE to use 
the default units set in Preferences. 

How to use . . .
Select the object. Then CLICK on Properties and 
CLICK on Celsius, Fahrenheidt, or Kelvin.

The SELECTED temperature object is recalculated and the temperature displays in the selected temperature.  



Display Order
This function provides the ability to change the vertical relationship of  
SELECTED OBJECTS to another object in the same location. 

How to use . . .
Select the object.  CLICK on Properties, and then CLICK on Display Order.  The sub menu shown  to the right will 
display next to and attached to the Properties Menu.  

Send Back One or Send Forward One - Move the selected object back one LAYER  (down when look at a vertical 
cross section) or forward one layer (up when looking at a vertical cross section). 

Send to the Front - Move a selected object in front of ALL other objects.

Send to the Back - Move a selected object back of ALL other objects.

The purpose of this function . .
This function has special uses in the software. For example - place an  Isotherm correctly in relationship  in complex 
temperature displays. 





Introduction to the Window Menu
Location
Frame Grabber Module, Image Editor, Report Editor and Graph Module.

The following functions are found in the Windows Menu  

8. Cascade
9. Tile
10. Arrange Icons
11. Close All
12. File List

Related topics
These should be reviewed when studying any of the properties menu items.

1. Editing objects chapter 3.
2. Using the mouse chapter 4. 
3. Speed menus chapter 5
4. Preferences chapter 6
5. Edit menu. 
6. GLOSSARY.

The Windows Menu
The Window Menu is shown to the right. 

This menu contains Windows functions useful in handling images. 

Introduction to Windows Menu Functions
The Windows menu has a set of functions that manipulate the software windows such as tile, and cascade.  It also has 
a useful LAST USED FILE.

The Windows Menu Functions
Cascade
Position  window or multiple windows (technically CHILD WINDOWS)  so that the very first one is located in the 
upper left hand corner of the main window (technically a PARENT WINDOW).

Windows are arranged such that the title are visible in a cascading manner. 

Due to the fact that a LIVE WINDOW in the Frame Grabber module is NOT RESIZEABLE it will assume the same 
size as all the other cascaded windows.



Tile
Arrange all the window or multiple windows so that they assume a TILED appearance within the main M9000 win-
dows. . 

Due to the fact that a LIVE WINDOW in the Frame Grabber module is NOT RESIZEABLE  or that this Windows 
functions does not take care of aspect ratios properly some distoration of the iimages will result.

This is primarily a tool for looking at a group of windows. It is especially useful with graphs, particularly LIVE 
GRAPHS.

This software also loads multiple images from the Load Images function and tile can be useful in looking at all of 
them in a mosaic.

Arrange Icons
CLICK on the - sign to ICONIZE  (windows 95 calls this an ICON when it is not,  the result of this function is a no  
name windows entity). Use this function to arrange the ICONS in order along the bottom of the main window.

Close All
Click on Close Windows and Click on CLOSE All.  The 
CONTROl shown below is displayed when there are mul-
tiple windows. 

NO - Do not save the selected windows entity.

YES - Click on this to save a selected windows entity.
A standard Windows file save control is displayed. See the example shown below and to the right.

NO TO ALL  - Click on this to close all the windows entities that ARE DISPLAYED.  Be very careful with this con-
trol since it will destroy those windows.  ONCE DONE THESE CAN’T BE RETRIEVED. 

CANCEL - change of mind - put away the menu without doing anything.







Introduction to The Report Menu

Location
Frame Grabber Module, Image Editor, Report Editor and Graph Module.

The following functions are found in the Report Menu  
1. Create Template
2. Create Report from Template
3. View Graph

Related topics
These should be reviewed when studying any of the Report Menu 
functions.

1. Chapter 4 - Using the Software
2. Chapter 5 - Events Menu
3. Chapter 6 - Edit Menu
4. Chapter 7 - File Menu
5. Chapter 15 - Batch Menu
6. Chapter 16 - Format Menu
7. Chapter 17 - Field Menu
8. Chapter 18 - Link Menu
9. Chapter 19 - Report Editor Objects Menu
10. Chapter 21 - Graph Mode Menu
11. Chapter 22 - Graph Settings Menu

Introduction to the Report Menu Functions
The Report Menu is shown to the right. 

This menu contains the functions that o access the template,  reporting and graphing functions of  the software. Or 
that access the Report Editor and Graph Module. These contain menus that have all the functions to create templates, 
make reports, and graph temperature data. 

The menu functions
Create Template
This function will load a blank template for the creation of a NEW TEMPLATE.
How to . . .
CLICK on Report and CLICK on Create Template. A blank report form is displayed.  

All of the tool bar, and menu functions needed to CREATE a NEW TEMPLATE become available. 

See chapter 20 for more information on the process of making templates.



When done with the work save the work by CLICKING on FILE and 
CLICKING on Save AS. Select the option in the drop down list for 
templates and save to the template directory created when the soft-
ware is installed.

Create Report from Template
This function loads a PREVIOUSLY CREATED TEMPLATE.

The intention of this function is to USE a TEMPLATE CREATED 
PREVIOUSLY FOR MAKING A REPORT. 
How to . . .
CLICK on Report and CLICK on Create Report from Template.  Use 
the standard Windows file load menu to access the directory containing the templates.  If templates are present they 
will show.  Double CLICK on anyone of these to load into the software, to make a report.  

Create Graph 
This function uses the software graph functions to graph temperature data  from Line, Rectangle, Shape, and Circle 
temperature objects. 

How to . . .
A temperature object must be selected to be displayed.

CLICK on Report and CLICK on CreagteGraph.

Multiple objects
The graph module is capable of displaying data on a single graph from more than one temperature 
object. These can be of the same kind or different kinds.  In otherwords the user can select a rectangle to 
display, a line, a circle, etc. The exception is that Line Temperature which does not have a histogram 
cannot be displayed with Shape, Circle, and Rectangle or histogram temperature data. 

Do this by HOLDING DOWN THE SHIFT KEY OR THE CTRL KEY and then Left Mouse Button clicking on each 
temperature object to be displayed. There is no real limit as to the number of objects selected other than the practical 
one of space for a meaningful display.

Line Temperature Objects cannot be mixed with histogram types - Rectangle, Circle, and Shape in Graph Type 2, and 
Graph Type 3 

CASE 1 - From LIVE IMAGES -
If this was done from the Frame Grabber module 
or from a LIVE IMAGE the Control shown to the 
right will be displayed.

This has three data display options 

Graph Type 1 - (Fixed.) This displays a SNAP-
SHOT of the temperature data extracted by the 
temperature object.

NOTE: this is available ONLY with LINE, RECTANGLE, SHAPE, and CIRCLE, because these temperature objects  
have multiple points.

Graph Type 2 - (Scroll by time).  Scroll by time takes the average of the selected object and adds it to the right of a 
graph while moving the data it replaces to the left (scrolling). The scrolling speed is determined by the settings in the 



Events - Set Measurement Rates.  Since it takes the average of the data it ignors Histograms if present in Rectangle, 
Circle, and Shape and takes its average temperature.

Graph Type 3 - (Updating but not scrolling) 
Temperature data is updated continuously. The Set Measurement Rates functions in the 
Events menu located in the Frame Grabber Module determines the update interval.

This type displays Line Temperature Object as the ACTUAL temperature along a line.Rectangle, Shape and Circle 
display a LIVE HISTOGRAM updated continuously. 

CASE 2 - From the Image Editor.

The Setup Graph dialog does not display. Clicking on Create Graph sends the software directly to the Graph 
Module.

This displays a SNAPSHOT ONLY of the temperature data extracted by the temperature object. All the temperature 
objects can be graphed in this case.





The View Menu
Location
Image Editor, Report Editor.

The following functions are found in the View Menu  
6. Zoom in
7. Zoom to Full Screen
8. Refresh
9. Display Order *

*Note: appears in Report Editor ONLY - found otherwise in the Properties Menu

Related topics
Chapter 4 - Setting Up the Software.
Chapter 11 - Properties Menu

NOTE: A preference setting, in chapter 4, Zoom to a New Window has a direct 
effect on how  Zoom to Full Screen works. See the section in this manual on the 
function Zoom to Full Screen

The View Menu functions
The View Menu is shown to the right.  

In this menu the user will find functions that allow Zooming a ROI and returning 
from a Zoom. 

Toolbars
There is no toolbar for the functions in the View Menu

The View Menu Functions
Zoom In
This function zooms a ROI drawn to full screen size. When the upper limit is reached the function prevents use.
How to . . .
Select an image in the Image Editor by CLICKING anywhere on the image.

Then CLICK on ZOOM In.  The mouse cursor changes into a MAGNIFYING GLASS with a + in the center. Use this 
tool to DRAW A RECTANGLE (ROI) on the Image, by DRAGING THE CURSOR TO DESCRIBE A RECGTAN-
GLE.  Release the mouse button and the ROI will ZOOM.

Report Editor

Image Editor



If Image Tab in preference is set to Zoom to Original 
Window each successive Zoom will use the same 
window. 

If new Window is Set - each Zoom will create a new 
window in which the ZOOMED IMAGE is dis-
played.  

A section of this preference IMAGE TAB is shown 
to the right. 

Zoom to Full Screen 
This function enables a return to the initial image 
magnification from a ZOOM. 
How to . . .
CLICK on View and CLICK on Zoom to Full Screen, and the image will restore to the original.

NOTE: This function works ONLY when the user has elected to ZOOM on the Original Window.  The Only way to 
return from a ZOOM, when preferences Zoom to a New Window is SET, is to select the STARTING IMAGE from 
which the first Zoom was taken and SELECT that Image for use.  Of course this method has the advantage of being 
able to save all zooms and selecting the most suitable ZOOM after review.

Refresh
CLICK on this function to remove ARTIFACTS from the image.  Infrequently bits and pieces of previous annotations 
are not removed by the normal UNDO, or REMOVE LAST, in which case this function is useful. 

Display Order
Refer Chapter 11 - Properties Menu for an explanation of this function. 



The Format Menu
Location
Report Editor ONLY. 

The following functions are found in the Format Menu  
1. Font
2. Default Font
3. Protect
4. Format Painter
5. Protect Document
6. Transparent
7. Background Color
8. Border Color
9. Text Color
10. Show Border
11. Show Label
12. Set Line Width
13. Autosize

Related Topics
Chapter 3 Setting up the software

Introduction to the Format Menu Functions
The format menu has functions that enable the software user 
to set object properties or attributes. Some of these functions 
such as transparent find specialized uses. 

The Format Menu Functions
The menu is shown to the right.  This menu has functions that 
relate to formate settings for objects used in the Report Edi-
tor.  With these functions, objects can have borders, adjust-
able line width, can be made transparent. The software user 
should study these functions since these add quality to any 
report.The menu functions

Font
Font sets the font, and font attributes for text used anywhere in the Report Editor.
For example it sets the font attributes for fields, as well as the text object.
How to . . .



Click on Format and Click on Font. The dialog control shown to the left displays and makes available controls that 
can change fonts, font size, and font color. Font color is duplicated by text control.  

The FORMATTING TOOL BAR makes it possible to easily and quickly change some of the attributes of text that is 
being used without using the Font function. 

Default Font
This function restores the font displayed on the Font Tool Bar to the settings contained in Preference, which is the 
default.
How to . . .
CLICK on the Format Menu and then CLICK on Default Font. 
Protect
Protect is used to enable Protect Document for a selected object ONLY.  If an object has been selected and PROTECT 
has been used, the KEY tool will always be depressed and the Format Menu Protect function will have a CHECK 
MARK next to it.
How to . . .

Select the object.  Then CLICK on Format Menu and CLICK on Protect. A CHECK MARK is placed next to 
the menu item indicating it is in effect. The KEY tool will also be depressed as shown to the left.

Protect Document
Protect locks all the objects in a template in place and prevents editing, or making changes to the template during its 
use in a report.

How to . . .
Protect is ALWAYS used with the KEY tool.  

Select the object and then CLICK on the KEY tool. Then CLICK on the Format Menu and CLICK on Protect. 

Key applies to an individual object and enables Protect.  Notice that a selected object previously KEYED will show 
this by DEPRESSING THE KEY TOOL. 

When making a template   

Format Painter
This function copies the format properties from one TEXT OBJECT to another.  It is necessary to copy these proper-
ties for each time it is used.

Format Painter is useful because it copies more than one property at one time to another object, and saves time.  It 
also results in a more uniform template.

How to . . .

Select the TEXT OBJECT which has the properties to be copied.  Click on Format Menu and then CLICK on Format 
Painter.  The ARROW cursor changes into a cursor with a PAINT BRUSH. Copy properties by selecting the object to 
which the properties are to be copied. 



The same thing can be accomplished by CLICKING on the Paintbrush Tool, found on the RIBBON BAR 
instead of using the Format Menu, which is much more convenient.

Transparent 
This function renders an object transparent, by removing its BODY COLOR so that effect is one of transparency.  
This has particular use with text that is to be placed over and image or an object. 

How to . . .
Select the object. Click on the Format Menu and then CLICK on Transparent.  The object MUST be brought to the 
front with the appropriate menu commands, or the speed menu. 

NOTE: If transparent is checked BACKGROUND COLOR is NOT AVAILABLE.  This shows as a 
GRAYED MENU ITEM. 

Background color
This function applies a background color to ALL OBJECTS.

ALL Objects are initially set to WHITE background and NONE TRANSPARENT, unless set differently. 

How to . . .
Select the object.  Then CLICK on Format and CLICK on Background.  A standard Windows color selection dialog 
displays.  Select a COLOR and then CLICK OK.

Border Color
This function applies a border color to ANY SELECTED OBJECTS.

ALL Objects are initially set to no border. 

How to . . .
Select the object.  Then CLICK on Format and CLICK on Border Color. A standard Windows color selection dialog 
displays.  Select a COLOR and then CLICK OK.

Text Color
This function applies a color to ALL SELECTED TEXT OBJECTS.

How to . . .
Select the object.  Then CLICK on Format and CLICK on Text Color. A standard Windows color selection dialog dis-
plays.  

Show Border
This function applies a border to ALL SELECTED TEXT OBJECTS.



ALL Objects are initially set to no border. 

How to . . .
Select the object.  Then CLICK on Format and CLICK on Show Border. A check mark is placed next to the border 
indicating that a border IS APPLIED to this selected object. A check mark is placed for each object selected that has 
a border. NOTE - use line width to set the width of the line, Border Color to change the color of a border.

Show Label 
This function applies a label to the temperature fields found in the 
Fields Menu. These are Point, Spot, Circle, etc. By default every tem-
perature field initially displays a label unless changed by this menu. A 
check mark is then displayed by default in front of the menu item.

How to . . .
Select the temperature field.  Then CLICK on Format and CLICK on Show Label. A check mark is placed next to the 
temperature field indicating that a LABEL IS APPLIED.  A check mark is placed for each temperature.

The circle field shown to the left has a visible label.

Set Line Width
This function sets the width of the line for ANY object that displays a border, along with the the vertical and horit-
zonal lines in the Object Menu.

How to . . .
CLICK on the Format Menu and then CLICK on Set Line Width.  The dialog box 
shown to the right appears. CLICK on the UP or DOWN arrows to INCREASE or 
DECREASE the width of the line.  A maximum of 25 is allowed.  These numbers are 
relative and do not signify an actual measurement.  When the correct width has been 
specified CLICK on OK to exit the dialog box to apply to a selected bordered object.  

CLICK on Cancel to EXIT without changing anything.

Autosize
This function sizes the width of a temperature field so that all the data appears.  For example a Line Temperature 
Field can be be lengthy and normally would be truncated unless autosize is applied.

How to . . .
Select the temperature field to autosize. CLICK on the Format Menu and then CLICK on Autosize. 

The Line 1 temperature field at the top is autosized so that 
ALL the data is visible.

The Line 1 temperature at the buttom is NOT so that most of 
the data is truncated.

Alternatively the user can SELECT the field and then resize 
manually by draging to the desired shape.

Label



The Field Menu
Location
Template Editor or Report Editor.  

Format Menu Functions 
1. Image
2. Point Temperature
3. Spot Temperature
4. Line Temperature
5. Rectangle Temperature
6. Circle Temperature
7. Shape Temperature
8. Units
9. Ambient
10. File Date
11. File Time
12. Current Date
13. Current Time
14. Index

Related Topics
Chapter 3 Setting up the software, Chapter 4 Using the Software, Chap-
ter 10 the Objects Menu, Chapter 18 the Link Menu. 

The Field Menu
The menu is shown to the right.  This menu has functions that allow the 
placing of fields in a template for use in making a report. 

Fields are available only when a image exists in the Image Editor and is 
linked by using the Link Menu functions.  If no link exists the fields menu is grayed with the functions unavailable.

Fields cause temperature DATA to move automatically from a temperature object placed on an image in the Image 
Editor to a linked image placed on a template or report in the Report Editor.  Edit made to an image in the Image Edi-
tor are AUTOMATICALLY updated in the Report or Template. 

Many of the functions associated with fields are available from speed menus accessed while selecting an object with 
a RIGHT MOUSE BUTTON CLICK. 

Multiple fields of the same type are identified uniquely by using the Index Function.  For example the user could have 
5 points located on ONE IMAGE and all placed in a template.  Each point is identified with a NUMBER, or a 
UNIQUE label if it is present. Once identified the correct data associated uniquely with that object is reported. 



Field properties
1. Removable or in the case of temperature field editable labels
2. Color settable borders
3. Sizable borders
4. Color settable background
5. Transparent
6. Dragable position and sizing
7. Font colors and font selection
8. Indexable with the Index function.
9. Linkable to any image located in the Image Editor with Change Link function.

All of the fields have identical properties. Editing, indexing, linking, labels, formatting with background, transparent, 
border, colors, etc., once learned can be applied to ANY ITEM in this Menu. Editing these is explained Chapter 4 on 
Using the Software. 

Image
This function enables the placing of images located in the Image Editor into a template or report. As many images as 
desired can be placed .

Applying this function is the SAME for both making a template by accessing the Create a Template function and 
making a report by accessing the Create a Report from a Template. In the next section a template only is referred to. 

How to . .

5. Place an image in the Image Editor, by loading from the File Menu, or CLICK on the TOOL shown to the 
right. This function is also in the Frame Grabber Menu in the Frame Grabber Module 

6. SELECT that image. 
7. CLICK on the Link Menu and CLICK on Set Initial Link. Select the image to which a Link is to be estab-

lished and CLICK OK. This CONTROL is shown to the right.
8. CLICK on Field and CLICK on Image. The image SELECTED in the Image Editor will be placed in the 

report. Edit that image to change the size or location on the template or report.

How to place additional images . . .

1. CLICK on Field and CLICK on Image to place more images in the template or report. All of these images 
will be the same util CHANGE LINK is USED.  

2. SELECT an image in the Image Editor. 
3. CLICK on the Link Menu and CLICK on Change Link. 

Select the Image to which a changed link is to apply, and 
CLICK OK.  The control shown to the right shows this 
being done. Notice that the image changes to the selected 
image.

How the software identifies the images . . .



Identifying multiple images or knowing what image is linked to a particular image in the Image Editor is possible in 
several ways. 

12. STATUS BAR - LEFT CLICK on the image in question 
to select. The status bar will display the name of the 
image.   In this case it is Image7. That image is shown 
below with its name shown at the top. 

13. A second method is to select the image in question and 
then CLICK on the LINK MENU and CLICK on Go to 
Linked Image.  The software will then select the 
LINKED IMAGE and bring it to FOCUS (to the front) in 
the software window. 

Temperature Fields
This function places a temperature field on the Template.  Tem-
perature fields permitt the automatic movement of temperature data from the temperature objects in the Image Editor 
to a Report. The software is capable of handling multiple fields associated with more than one temperature object of 
the same type or reporting correctly temperature fields associated with multiple images.

Linking is necessary to make a temperature field active. 

The temperature fields are Point, Spot, Line, Rectangle, Circle, and Shape. 

The anatomy of a temperature field
This field is shown AS SELECTED and normally 
would not have the black handles (rectangles) visible. 
Every field available to the software user has common 
properties, such as borders, justification, background, 
etc.

Note the custom label to make very descriptive what 
temperature the field is reporting

Resize of the field is accomplished by placing the 
Mouse Cursor on any one of the black rectangles and 
then while HOLDING DOWN the Left Mouse Button 
dragging the mouse. Moving a field is done by placing 
the Mouse Cursor anywhere on the field HOLDING DOWN the Left Mouse Button and moving the mouse. 

As many colors as desired can be applied to borders, text, and background. Text size and font is completely select-
able.

If for some reason autosize has been turned off CLICK on Format and then CLICK on Autosize to make it the default 
once again. Otherwise in working through the section below rectangle data would be truncated.

How to . . .
All the temperature objects are applied in EXACTLY the same way.

Custom Label made with with Label function
in Image Editor

Temperature Stats - Average, Minimum, and
Maximum

Line Temperature Field

White background applied

Center justification applied

Border applied

Selected field - Handles for resize



Click on any one of the temperature fields. If you placed a point it would look like the illustration 
to the right. Fault is the Label associated with the first point in the INDEX.

The software has functions that will report the correct temperature for multiple points with the 
same lable.

There are several conditions that can apply:

CASE 1
MORE THAN ONE TEMPERATURE FIELD OF THE SAME TYPE ON THE IMAGE.   Place a temperature 
field on the template. It will be the same as the first one placed. Select the temperature field and then CLICK on 
Fields and CLICK on Index. Then Use the UP/DOWN arrow on the control to step through each temperature object 
of the same type that exist in the image. In this case our example is a POINT and the second one is labeled reference.
  

CASE 2
A TEMPERATURE FIELD OF A DIFFERENT TYPE FROM THE ONE ALREADY ON THE TEMPLATE AND 
ON THE SAME IMAGE. 
To illustrate what is meant - place a POINT a second POINT according to the above procedure, and then place a rect-
angle. 

Place the desired temperature field on the template. It will show N/A. Add the temperature object to the image Image 
Editor that corresponds to the the temperature field. N/A will change to temperature.  

Multiple temperature fields would be handled like that above. 

CASE 3
A TEMPERATURE FIELD OF THE SAME TYPE BUT LOCATED 
ON A DIFFERENT IMAGE.
To illustrate what is meant - place a RECTANGLE and then a SEC-
OND RECTANGLE on a second IMAGE. Place the desired tempera-
ture field on the template.  It will show the SAME TEMPERATURE 
as the FIRST TEMPERATURE FIELD OF THE SAME KIND.  Then 
CLICK on the Link Menu and CLICK on Change Link. Select the 
Second Image.  See the illustration on the RIGHT.  The temperature will change to the temperature obtained in the 
second image.

Units
This function places a field on the template or report indicating if  if Centigrade, Farenheidt, or 
Kelvin was used. 



How to . . .
CLICK on the Fields Menu and CLICK on Units. A fields menu like that one shown to the LEFT. 
NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

Ambient
This function places a ambient field on the template that reports the ambient temperature of the 
image. This is useful for a REFERENCE. This is NOT a true ambient but reports the internal tem-
perature of the camera reported temperature. Each edited image can have its own ambient temper-
ature. 

How to . . .
CLICK on the Fields Menu and CLICK on Units. A fields menu like that one shown to the LEFT. 

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

 How to . . .
CLICK on the Fields Menu and CLICK on ISOTHERM. A field like that one shown to the LEFT is placed on the 
template.

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

File Date
This function reports the date the Image was saved to a disk file, or if creating an 
image by using the Edit Image function in the frame grabber.  Format is in (label) 
day/month/year format.

How to . . .
CLICK on the Fields Menu and CLICK on File Date.  A field like that one shown to the LEFT is placed on the tem-
plate.

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

File Time
This function reports the time the Image was saved to a disk file, or if creating an 
image by using the Edit Image function in the frame grabber.  Format is (label) 
hours/minutes/seconds (24 hour time).

How to . . .
CLICK on the Fields Menu and CLICK on File Time.  A field like that one shown to the LEFT is placed on the tem-



plate.

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

Current Date
This function reports the computer date.  Format is in (label) day/
month/year format.

How to . . .
CLICK on the Fields Menu and CLICK on File Date.  A field like that one shown to the LEFT is placed on the tem-
plate.

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

File Time
This function reports the time.  Format is (label) hours/minutes/seconds (24 
hour time).

How to . . .
CLICK on the Fields Menu and CLICK on File Time.  A field like that one shown to the LEFT is placed on the tem-
plate.

NOTE: The first application of this field always reports on the image selected for the one set in Initial Links, to 
change to another image located in the Image Editor CLICK on Links, and then CLICK on Change Links. Select the 
desired image and CLICK OK. 

Index
This function changes the INDEX number of a field.

This number is not always visible as in the case of user entered temperature object label, or the none temperature 
fields. 



For example if there are 3 points placed on an image, and there 
are 3 point fields in a template,  Index is used to connect each of 
those point fields to a corresponding temperature point. 

The relationship of Index to the Link function. 

14. Set INITIAL LINK - sets the default LINK for 
SELECTED Image and all fields and images placed 
in the report.  

15. Change Link - establishes a LINK between SEC-
OND, THIRD, and MORE images and a selected FIELD or IMAGE in a template. 

The practical effect of item 1 is that all the images and temperature fields will have identical values. Usually only 1 
image and 1 set of temperature values retain the initial link and all subsequent images and temperature fields are 
changed with item 2.

How to . . .
The steps

16. Select the field. 
17. Then CLICK on Field Menu and CLICK on Index.  The Control shown ABOVE and to the RIGHT is dis-

played.  
18. CLICK on the UP arrow until the selected field displays correct index, determined by the correct displayed 

value or label.  Note that the temperature for the field is displayed for reference. 
19. CLICK OK





The Link Menu
Location
Template Editor or Report Editor. 

The following functions are found in the Link Menu 
5. Set Initial Link
6. Change Link
7. Go To Linked Image

Related Topics
Chapter 17 - The Field Menu

Related Tool Bars 
There are no related toolbars. 

F Keys
1. F2 - Set initial link
2. F3 Change Link
3. F4 Go to Linked Image

The Link Menu
The LINK MENU is a deceptively simple menu.  With these functions the user can set up a report so that temperature 
data and images is entered in a report and temperature data is automatically updated. The software user should make 
sure that this topic is thoroughly understood.

In this chapter both TEMPLATES and REPORTS are discussed almost interchangeably. The user needs to understand 
that the Report Editor is used to BOTH creates new templates, edit templates, and to make reports based on templates 
previously created.

The Link Menu is shown to the right. This menu has functions that enable the management of LINKS to Images, all 
the Fields located in the Fields Menu, and Text Annotation.

Linking is used to establish automatic communication between the Image Editor and a Report or Template. This 
means that data is automatically sent from a temperature object in the Image Editor to a corresponding linked field. 
Any changes made to the IMAGE in the Image Editor is ALSO made to the LINKED IMAGE in the template or 
report.

Links are SAVED along with the template. This means all the necessary links can be done while making a template 
and then used in a report made from that template. This process can be done repeatedly without going through the 
time and work of making a new report each time - ONLY parts that need to are readily changed. 
 



Two must understand LINKING topics 
1. If an image is loaded first in the Image Editor and then the Report Editor is opened -- an INITIAL LINK is 

established with that image. All fields, images, and text will be linked. Multiple fields of the same type will 
display the same data until changed with CHANGE LINK. A link established this way is a default link is no 
different from what is accomplished by using Set Initial Link explained below.

2. If no image is loaded first and the Report Editor is LOADED FIRST --- NO INITIAL LINK is established. 
Fields, and Images will be grayed out, and unavailable. In this case use Set Initial Link explained below.

 

Set Initial Link
This function sets the INITIAL LINK for every image and field placed on the template or report. This remains true 
until CHANGE LINK is used on a selected image or field. 
Its use is PRIMARILY to set a LINK when an image was not loaded first. 
How to...
In the Image Editor load an image. Then go to the Report Editor and 
CLICK on the LINK Menu and then CLICK on Set Initial Link. 
Select image desired. In the example to the right there are three 
images available, and the user would be free to select any one of 
those. 

This control shows for viewing ONLY images that are currently 
loaded into the Image Editor. 

When the selection is made CLICK on OK, and the Initial Link is 
established. All the fields in the fields menu are then ungrayed and available to the user.

Change Link
This functions changes a link from that established by Initial Link to a link with second images located in the Image 
Editor. It is also used to Change Link to fields so that the data they report on can be different from the one set in Initial 
Link. 

This function permits MULTIPLE IMAGES to be placed in a report. 

How to...
There are two ways to use this function. 

1. Select an image in the image editor and then CLICK on Link and CLICK on Change Link and select the 
image that is to be changed. Then place this image in the Template.

2. Place multiple images, fields, etc. in the Template. These will all have exactly the same data. Select the field 
or image to be changed and then CLICK on Link and CLICK on CHange Link. Select the image and CLICK 
OK. The image selected in the Report Editor will change to the image selected in Change Link.

Go to Linked Image 
This function selects the Linked Image in the Image Editor. The software user is moved to the Image Editor and the 
appropriate image is selected.

How to...
Select the Field or Image and then CLICK on Link and CLICK on Go to Linked Image.







Menu  
The Object Menu
Location
Report Editor 

The following functions are found in the Link Menu 
7. Rectangle Annotation
8. Line Annotation
9. Text Annotation

Related Topics 
Chapter 17 - The Field Menu, Chapter 15 Format Menu. 

The Objects Menu
This menu provides basic objects that can be placed on a report.  These function the same way as those in the Image 
Editor, and are editable exactly the same as any other object.

Rectangle Annotation
Use this function to place a rectangle OR BOX on the report.  It is especially usefull for attention getting items on a 
report such as a title, a fill comments section, or a footer.
How to...
CLICK the mouse anywhere the UPPER LEFT HAND CORNER of the rectangle is to be placed.  Then CLICK on 
Objects and CLICK on Rectangle Annotation.  A rectangle is then placed on the report.  It is sized to a standard size.

To edit. 
Click on the RECTANGLE to SELECT.  Selection is indicated by the BLACK rectangles on the corners of the rect-
angle.  Place the mouse cursor on the any one of the rectangles and hold down the left mouse mouse and move the 
mouse to resize the rectangle into any desire shape. 



CLICK the Left Mouse button anywhere on the rectangle and hold down the left button 
while moving the mouse to DRAG the rectangle to a desired position.  Note that the 
rectangle outline becomes dotted and SEE THROUGH.  

Speed Menu 
Select the rectangle and then CLICK the RIGHT MOUSE button. The speed menu 
shown to the right displays.  Select various functions EXACTLY the same as if the 
main menus were accessed. 

See Chapter 16  Format Menu for an explanation of these commands.

Line Annotation 
Use this function to place a line on the template or report.  It is especially useful for 
separating section of the report.  Placing two lines in close proximity and both vertical and horizontal results in inter-
esting LOGO EFFECTS.

How to . . .
CLICK the mouse anywhere on the template where  the LEFT END of a LINE is to be placed.  Then CLICK on 
Objects and CLICK on Line Annotation.  A LINE  is then placed on the report.  It is sized to a standard size.

To edit. 
Click on the LINE to SELECT.  Selection is indicated by the BLACK rectangles on the ENDS of the LINE.  Place the 
mouse cursor on the any one of the rectangles and hold down the left mouse mouse and move the mouse to resize the 
line or position at any angle.  

CLICK the Left Mouse button anywhere on the LINE and hold down the left button 
while moving the mouse to DRAG the LINE to a desired position.  

Speed Menu 
Select the rectangle and then CLICK the RIGHT MOUSE button. The speed menu 
shown to the right displays.  Select various functions that are  EXACTLY the same as if 
the main menu was accessed. 

See Chapter 16  Format Menu for an explanation of these commands.

Text Annotation
Text Annotation function places a text frame into a report with many of the attributes of 
RICH TEXT.

The properties of TEXT ANNOTATION

13. Font attributes such as font color, font size, underline, fonts are can be applied to selected text.
14. Text frame attributes such as background color, transparent.
15. Text as it is placed in the text frame ALWAYS scrolls down so the entered text line is visible.
16. Text wraps around to the next line.
17. Text fits adjustments to the text frame automatically.

Hot to . . .



A.  Placing a TEXT OBJECT or FRAME on the template or report.

7. CLICK on the TEXT TOOL or CLICK on the Object Menu and 
then CLICK on Text Annotation. The text frame show to the right 
is placed on the screen in the upper right hand corner.

8. IF resizing is required CLICK on the template or report outside 
the borders of the TEXT TOOL and then CLICK on the borders 
of the TEXT OBJECT. It then will look like the box with rectan-
gles shown to the RIGHT.  CLICK on any of the RECTANGLES 
and DRAG to the desired shape. 

9. If repositioning is required LEFT CLICK the MOUSE anywhere 
on the text object shown to the right and DRAG to a new posi-
tion. ALSO DO THIS WHEN TEXT IS WRITTEN IN THE 
FRAME. 

10. To use the text box place the MOUSE CURSOR inside that box and DOUBLE CLICK the LEFT MOUSE 
BUTTON.  The text box then reverts to the one at the top and the user can start to type in text. ALSO DO 
THIS WHEN TEXT IS WRITTEN IN THE FRAME. 

B: Placing text in the text frame.
1. Type as much text as desired.  The software will auto word wrap and scroll down to always make the line 

being written visible.
2. To make all of this text visible do item A.2. on the previous page to resize.
3. Use end, home, up or down arrow to move around the text.
4. To EDIT the text SELECT and HIGH LITE the 

desired text.  THEN APPLY ANY OF THE 
DESIRED FONT ATTRIBUTES by using the 
TOOL BAR shown to the left. These are 
explained in Chapter 15 - The Format Menu. 

C: Formating the text frame
1. Applying a BORDER COLOR  A text frame always 

has a border of the same color as the background of a 
text frame. To change this color RIGHT CLICK the 
Mouse anytime the text frame is selected (when it is 
possible to enter text) and then click on BORDER 
COLOR. Make a selection from the WINDOWS 
COLOR SELECTION CONTROL and CLICK OK. 

2. To change the border width, select the TEXT FRAME 
as in item 1 above and  CLICK on LineWidth and 
adjust the SELECT LINE WIDTH control to the 
desired width.

3. To apply a color other than white to the background of 
the TEXT FRAME. Select as in C:1. and then RIGHT 
CLICK the Mouse button and then click on Back-
ground Color. Make a selection from the WINDOWS COLOR SELECTION CONTROL and CLICK OK.  
Make sure that transparent  DOES NOT HAVE CHECK MARK.

4.





Introduction to the Graph Mode Menu
Introduction

Location
Graph Module ONLY 

The Functions Found in the Mode Menu 
5. Horizontal Bar
6. Bar
7. Spline
8. Line
9. Spline w/Points
10. Points
11. Area
12. Stacked Bar
13. Stacked Area
14. Zoom to Full Screen

Related Topics 
Chapter 13 - The Report Menu

Introduction to the Graph Menu Functions
With these functions the software user can set the kind of display, such as bars, lines, splines, etc. There is also a 
ZOOM function.

The Graph Mode Menu Functions
This menu provides basic functions for setting the way objects, fields, and images are viewed.Rectangle Annotation.

Create Graph function available only the REPORT MENU is included in this chapter because it is material that needs 
very careful review.

Using the Graph Module 
This function uses the software graph functions to graph temperature data  from Line in the Image Editor. Spot, and 
Point are also available in the Framegrabber Module, from live images.  

How to . . .
A temperature object must be selected to be displayed.

CLICK on Report and CLICK on CreateGraph.



Multiple objects
The graph module is capable of displaying data on a single graph from more than one temperature 
object. These can be of the same kind or different kinds.  In otherwords the user can select a rectangle to 
display, a line, a circle, etc. The exception is that Line Temperature which does not have a histogram 
cannot be displayed with Shape, Circle, and Rectangle or histogram temperature data. 

Do this by HOLDING DOWN THE SHIFT KEY OR THE CTRL KEY and then Left Mouse Button clicking on each 
temperature object to be displayed. There is no real limit as to the number of objects selected other than the practical 
one of space for a meaningful display.

CASE 1 - From LIVE IMAGES -
If this was done from the Frame Grabber module 
or from a LIVE IMAGE the Control shown to the 
right will be displayed.

This has three data display options 

Graph Type 1 -
 (Fixed.) This displays a SNAPSHOT of the temperature data extracted by the temperature object.

NOTE: this is available ONLY with LINE.

Graph Type 2 - 
(Scroll by time).  Scroll by time takes the average of the selected object and adds it to the right of a graph while mov-
ing the data it replaces to the left (scrolling). The scrolling speed is determined by the settings in the Events - Set 
Measurement Rates.  

Graph Type 3 - (Updating but not scrolling) 
Temperature data is updated continuously. The Set Measurement Rates functions in the 
Events menu located in the Frame Grabber Module determines the update interval.

This type displays Line Temperature Object as the ACTUAL temperature along a line. 

CASE 2 - From the Image Editor.

The Setup Graph dialog does not display. Clicking on Create Graph sends the software directly to the Graph Module.

This displays a SNAPSHOT ONLY of the temperature data extracted by the temperature object.

The Mode Menu Functions 

Horizontal
Plots data in horizontal bars.

Bar
Plots data in vertical bars.



Spline
Plots a interpolated line from point to line for a smoothing effect.

Line
Plots a line from point to point.

Points
Places a MARK at the X and Y coordinates of each data point.

Area
Fills in the area under a LINE PLOT with a color.

Stacked Bar
Plots data in vertical bars with each bar filled in with subsets of data.

Stacked Area
Plots data under a AREA PLOT with subsets of data.

Zoom to Full Screen
The software user can select an area of the graph and zoom this to the graph size. Restore to original is permitted with 
this function. 

How to . . .
Zoom to Full Screen is grayed until a ZOOM has taken place as described below, when it becomes available.
How to ZOOM a graph  . . .
Hold down the LEFT SHIFT key on the computer keyboard. Then WHILE HOLDING DOWN the LEFT MOUSE 
BUTTON move the mouse to draw a rectangle around the graph data that is to be zoomed. When satisfied with the 
area release the mouse button.  Effect - the selected area zooms to the full graph size.

How to RESTORE a graph from a zoom . . .
To Restore the graph CLICK on Zoom to Full Screen. Note that when this is done the function ONCE MORE 
becomes grayed. 

 

 





The Settings Menu

Location
Graph Module ONLY 
The following functions are found in the Settings 
Menu 

1. Table
2. Grid
3. Setup
4. Range
5. Save Settings
6. Load Settings

Related Topics 
Chapter 13 - The Report Menu, Chapter 21 Graph Mode Menu

Introductions to the Settings Menu 
Functions

This menu enables the software to customize the graph to the user’s individual preference.

The Settings Menu Functions

This menu provides basic functions that 
determine how the graph displays data. It also 
has functions that determine the apppearance 
of the graph.

Table
This function displays a table of the tempera-
ture data like that shown to the right, for 3 
line temperature objects. The table shows the 
temperature at each vertical grid. 



The resolution or number of temperatures dis-
play per grid can be increased by selecting a 
smaller sequentual value for scrolling. See 
Setup for settings that effect the display of 
table value. 

The software can display a table along or a 
table with a graph. 

The data for a histogram shown to the right is 
slightly different.
How to . . .
Click on Settings and then CLICK on Table. 
The popup menu shown to the right displays. CLICK on Graph w/Table to place a table 
with a graph. CLICK on Graph to remove a table.  

Grid
Grid contains basic functions that change the display of a graph. 

How to . . .
CLICK on Settings, and then CLICK on Grid. A popup menu shown to the right displays. 

Vertical, Horizontal, Both, None. 
These will place GRIDS on the graph to make it easier to read some graph data. 

Thin, Thick, Dotted, Dashed
These adjust the appearance of the GRID LINES to a user preference.

Front, Back 
A GRID can be placed in front of or behind the GRAPH DATA.

Setup
CLICK on Settings and then CLICK Setup to access the tabed controls shown below. 

TAB - General 
Use these to customize the appearance of the Graph. 



Tab - Plot Style

TAB - Subsets 

The software has the ability to display a graph of data selectively. In the example shown there are two graphs plots 
shown at one time. The user can VIEW by USING THE SCROLL BAR plots for LINE 3, 4, 5, with LINE 1 
ALWAYS being viewed as a COMPARISON.

This function is useful for viewing crowded complex plots, or as a comparison view.

A subset is a method of separate multiple plots into individual ones for the purpose of VIEWING. There ARE NO 
data changes. 

Editable GRAPH
TITLE

Editable Sub Title

Select  
Color Graph
Monochrome
Monochrome w/markers

Select Font Size

Set number of decimal
places  in GRAPH
DATA

Grid Settings

Display TABLE
w/Graph

Show ALL Graph
data or  SUBSET

Not available to
USER

Use 3d
Shadows effect

Mark Graph
Data points

Select type of
GRAPH

Not available to
USER



NOTE: Scrolling subsets REQUIRE A MINIMUM of 1 to function.

Example of graph with subsets.  Note Line 1 is always VIEWED, and Line 3 has been viewed by scrolling. Line 4 
and 5 shown visible in SUBSET TAB screen, shown above, are also viewed INDIVIDUALLY with the scroll bar on 
the right of the graph. 
How to . . .
Select the temperature object to be ALWAYS VIEWED. Line 1 is shown as selected in the above view. Then select 
how many of the temperature objects are ALSO to be displayed each time the scroll bar is used. In the example 
ONLY 1 is selected.  NOTE use the Ctrl KEY to select with a CONTROL. 

TAB - Points

Select VIEWED
object or objects

Select HOW MANY
OBJECTS are viewable
by SCROLLING at ONE
time.

LINE 1 - Always
viewed

Scroll Bar

LINE 3 - Viewable
with the use of
SCROLL BAR



The software has the ability to display a SELECT NUMBER OF DATA POINTS either by scrolling or STATIC
 SELECTION. A graph displays data point by default, unless it is a HISTOGRAM, every 10 degrees. This is a way of 
magnifying a graph by selecting a number of data points or a graph SEGMENT based on those data points. ]
Sequential
Limited to 100 data points displayed at ONE TIME.  Settable down to 2 data points by SCROLLING. The example of 
a graph with the scroll bar active is shown below. 
Selected 
Select a single number or a range of numbers.  A number of ranges or sets of ranges can also be selected. Again use 
Ctrl KEY.  For example the use could select 123 23 24 25 150 151 153. 

The range of numbers is DETERMINED EXACTLY by the length of the line temperature object which is the number 
of PIXELS in a LINE, with EACH PIXEL reporting a temperature.  

A HISTOGRAM display ALWAYS has 256 points available with NO REFERENCE to temperature.

If the a scroll by time is selected for graphing a Line Temperature object it is possible to select a RANGE of TIME to 
display. 

REAL TIME graphing is by its nature changing and dynamic, so there are limits on what can be done with a time dis-
play - a user could never go back in time to view a temperature object by graphing. 

Select the number
of DATA POINTS
to DISPLAY

Select the number
of DATA POINTS
to display by
SCROLLING.



TAB - Font
This Customization page allow the user to set a Font and Font Attributes for a particular section of the graph

Main Title 
Select a Font, bold, italic, or underline.  It is not possible 
to set the FONT size.
The title as in the example to the right is Main Title - the 
software user can change this by selecting the General 
Tab.

Sub-Title
Select a Font, bold, italic, or underline.  It is not possible 
to set the FONT size.

The sub-title as in the example to the right is Histogram - 
the software user can change this by selecting the Gen-
eral

Main Title 
Select a Font, bold, italic, or underline.  It is not possible to set the FONT size.
The title as in the example to the right is Main Title - the software user can 
change this by selecting the General Tab.

Sub-Title
Select a Font, bold, italic, or underline.  It is not possible to set the FONT size.
The sub-title as in the example to the right is Histogram - the software user can change this by selecting the General 
Tab. That sub-title could be Histogram of Steel Slab, or anything else the user desires.

Subset/Point/Axis LabelsSubset - the LEGEND at the top of the graph indicating which SUBSET is displayed.
Point - numbers, and legends that are associated with the X (horizontal) and Y (vertical) axis of the graph. 
Axis Labels - not available to user

 An example is shown below using the settings in the Custimization Page below.

Scroll Bar

Reduced number
of POINTS
plotted.



TAB -  Color

This Page Customization provides the ability to change graph colors to a user preference.

Desk Foreground - Sets the font color for the point informa-
tion.
Desk Background - Sets the color behind the point informa-
tion.  If foreground and background are the same color they 
will become POINT information will become hard to see.
Shadow Color - sets the color of the shadow or 3d effect.
Graph Foreground - sets the color of the GRID
Graph Background - sets the background color of the 
graph.
Table Foreground - sets the text color on the table.
Table Background - sets the background color of the table.
Save Settings
This function saves changes made to Setup in a file.  The 
user can provide the file name, and location. This permitts 
individual customization of graphs, which are different from those setup in Preferences.
How to . . .
When changes are made CLICK on Settings, and then CLICK on Save Settings.  If settings are temporary either save 
under a new name of elect not to save changes.
Load Settings
This function loads previous changes made to Setup into the software. This needs to be done each time a graph is 
used. Normally a graph setup will load from what is done in Preferences.. 
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Functions 
Function Menu 
Location Manual Location Software Location

Acknowledge Alarms Events Chapter 3 The Events Menu FG

Add Isotherm Image Chapter 7 Image Menu FG and Image Editor

Arrange Icons Windows Chapter 11 Windows ALL

Adjust Palette Image Chapter 7 Image Menu Image Editor & FG 

Ambient Field Chapter 16 Field Menu Report Editor

Apply Palettes to all Images Image Chapter 9 Image Menu Image Editor & FG

Area Graph Mode Chapter 18 Graph Mode Menu Graph Module

Arrange Icons Windows Chapter 12 Windows . . . All

Assign Labels Object Chapter 9 Object Menu Image Editor & FG

Autosize Format Chapter 14 Format Menu Report Editor

Back 1 Frame Replay Tool Chapter 8 Special Tool Bars Replay viewer

Background Color Format Chapter 14 Format Menu Report Editor

Bar Graph Mode Chapter 18 Graph Mode Menu Graph Module

Border Color Properties Chapter 14 Format Menu Report Editor, Image Editor
and Frame Grabber Module

Bring to Front Properties Chapter 10 Properties Menu Image Editor,  FG

Bring Forward Properties Chapter 10 Properties Menu Image Editor, FG

Camera Controls Frame Grabber Chapter 6 Frame Grabber Frame Grabber



D

Cascade Windows Chapter 11 Windows . . . All

Celsius Properties Chapter 9 Properties . . . Frame Grabber & Image Editor

Change Link Link Chapter 16 Link Menu Report Editor

Circle Annotation Object Chapter 9 Object Menu Image Editor & FG

Circle Exclusion Object Chapter 9 Object Menu Image Editor & Frame Grabber

Circle Temperature Object Chapter 9 Object Menu Image Editor & FG

Circle Temperature (field) Field Chapter 16 Field Menu Report Editor

Close File Chapter 5 File Menu All

Close All Windows Chapter 11 Windows . . . All

Color Image Chapter 9 Image Menu Image Editor and FG

Copy Edit Chapter 4 Edit Menu Image Editor, Frame Grabber, 
and Graph

Create Report from Template Report Chapter 12 Report Menu All

Create Template Report Chapter 12 Report Menu All

Create Graph Report Chapter 12 Report Menu All

Current Date Field Chapter 15 Field Menu Report Editor

Current Time Field Chapter 15 Field Menu Report Editor

Cut Edit Chapter 4 Edit Menu Image Editor and Framegrab-
ber

Default Font Format Chapter 14 Format Menu Report Editor

Delete Objects Edit Chapter 4 Edit Menu All Image Editor and Frame 
Grabber Module

Delete Isotherm Image Chapter 7 Image Menu Image Editor & FG

Display Isotherms Image Chapter 8 Image Menu Image Editor & FG

Display Order Properties Chapter 11 Properties . . . Image Editor & FG

Duplicate Edit Chapter 6 Edit Menu Report Editor

Function Menu 
Location Manual Location Software Location



G

F

E

Edit Image Frame Grabber Chapter 6 Frame Grabber Frame Grabber Module and 
Replay Viewer

Edit Objects Edit Chapter 4 Edit Menu Image Editor and Frame Grab-
ber Module

Edit ROI Events Chapter 3 The Events Menu Frame Grabber

Emissivity Adjust Object Chapter 9 Object Menu Image Editor & Frame Grabber

Export File Chapter 5 File Menu Graph Module

Exit File Chapter 5 File Menu All

Fahrenheit Properties Chapter 11 Properties . . . Frame Grabber & Image Editor

Fast Save Events Chapter 3 The Events Menu Frame Grabber

Fast Forward Replay Tool Bar Chapter 8 Special Tool Bars FG & Image Editor, Replay 
Viewer

File Date Field Chapter 15 Field Menu Report Editor

File List Windows Chapter 12 Windows . . . All

File Time Field Chapter 15 Field Menu Report Editor

Fill Shape Properties Chapter 11 Properties . . . Frame Grabber & Image Editor

Forward 1 Frame Replay Tool Bar Chapter 8 Special Tool Bars FG & Image Editor

Font Properties Chapter 11 Properties . . . Frame Grabber & Image Editor

Font Format Chapter 14 Format Menu Report Editor

Format Painter Format Chapter 14 Format Menu Report Editor

Freehand Shape Exclusion Object Chapter 9 Object Menu Frame Grabber & Image Editor

Freeze Frame Grabber Chapter 8 Frame Grabber All

Go to Linked Image Link Chapter 16 Link Menu Report Editor

Function Menu 
Location Manual Location Software Location
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H

Gray Image Chapter 8 Image Menu Image Editor & Frame Grabber

Grid Settings Chapter 21 Customizing  Graph Graph Module

Horizontal Bar Graph Mode Chapter 18 Graph Mode Menu Graph Module

Image Subtraction Image Chapter 8 Image Menu Frame Grabber and Image Edi-
tor

Image Field Chapter 16 Field Menu Report Editor

Import File Chapter 5 File Menu All

Index Field Chapter 15 Field Menu Report Editor

Isotherm Image Chapter 8 Image Menu Image Editor & Frame Grabber

Instant Save Toolbar - Stan-
dard

Chapter 2 Using the Software Standard Toolbar

Kelvin Properties Chapter 10 Properties . . . Image Editor & Frame Grabber

Line Graph Mode Chapter 18 Graph Mode Menu Graph Module

Line Annotation Object Chapter 9 Object Menu Image Editor & Frame Grabber

Line Annotation Object Chapter 17 Report Editor 
Object  Menu. 

Report Editor

Line Temperature Object Chapter 9 Object Menu Image Editor & Frame Grabber

Line Temperature (field) Field Chapter 16 Field Menu Report Editor

Line Width Properties Chapter 10 Properties . . . Image Editor, Frame Grabber 
and Report Editor

Function Menu 
Location Manual Location Software Location



R

P

O

M

Load Events File Chapter 5 File Menu Frame Grabber

Load Palette Image Chapter 9 Image Menu Image Editor & Frame Grabber

Load Settings Settings Chapter 21 Customizing the 
Graph . . .

Graph Module

Log to Excel Events Chapter 3 The Events Menu Frame Grabber Module

Move Back Properties Chapter 10 Properties

Minigraph Options Properties Chapter 10 Properties . . . Image Editor & Frame Grabber

Open File Chapter 7 File Menu All

Page Setup File Chapter 7 File Menu Graph Module, Report Editor, 
and Image Editor

Paste Edit Chapter 4 Edit Menu All - Except Graph

Point Temperature Object Chapter 9 Object Menu Image Editor & Frame Grabber

Point Temperature (field) Field Chapter 16 Field Menu Report Editor

Points Graph Mode Chapter 18 Graph Mode Menu Graph Module

Preferences File Chapter 7 File Menu All

Print File Chapter 5 File Menu All

Print Preview File Chapter 5 File Menu Image Editor & Graph Module

Print Setup File Chapter 5 File Menu All - except Frame Grabber

Protect Format Chapter 14 Format Menu Report Editor

Protect Document Format Chapter 14 Format Menu Report Editor

Function Menu 
Location Manual Location Software Location



S

Range Settings Chapter 21 Customizing the 
Graph . . .

Graph Module

Recent File List File Chapter 5 File Menu All

Rectangle Annotation Object Chapter 9 Object Menu Image Editor & Frame Grabber

Rectangle Annotation Object Chapter 17 Report Editor 
Object  Menu. . 

Report Editor

Rectangle Exclusion Object Chapter 9 Object Menu Image Editor & Frame Grabber

Rectangle Temperature Object Chapter 9 Object Menu Image Editor & Frame Grabber

Rectangle Temperature (field) Field Chapter 16 Field Menu Report Editor

Redo Edit Chapter 4 Edit Menu All

Refresh View Chapter 13 View Menu Image Editor & Report Editor

Remove All Objects Edit Chapter 4 Edit Menu All

Rewind Replay Tool Bar Chapter 8  Special Tool Bars FG & Image Editor

Run Frame Grabber Chapter 6 Frame Grabber All

Run Replay Tool Bar Chapter 8  Special Tool Bars Replay Viewer

Save File Chapter 5 File Menu All

Save All File Chapter 5 File Menu All

Save As File Chapter 5 File Menu All

Save Events File Chapter 5 File Menu Frame Grabber

Save Settings Settings Chapter 21 Customizing the 
Graph . . .

Graph Module

Send Backward Properties Chapter 10 Properties Frame Grabber & Image Editor

Set Ambient Frame Grabber 
and Image 

Chapter 6 Frame Grabber Image Editor & Frame Grabber

Set Color Properties Chapter 10 Properties . . . Frame Grabber & Image Editor

Set Initial Link Link Chapter 17 Link Menu Report Editor

Set Line Width Format Chapter 14 Format Menu Report Editor

Set Measurement Rates Events Chapter 3 The Events Menu Frame Grabber

Function Menu 
Location Manual Location Software Location



T

Set Object Emissivity Properties Chapter 11 Properties . . . Frame Grabber & Image Editor

Set Scene Emissivity Frame Grabber Chapter 6 Frame Grabber Frame Grabber Module

Set Scene Transmission Frame Grabber Chapter 6 Frame Grabber Frame Grabber Module

Setup Settings Chapter 21 Customizing the 
Graph . . .

Graph Module

Setup Analog Output Events Chapter 3 The Events Menu Frame Grabber Module

Setup Events Events Chapter 3 The Events Menu Frame Grabber Module

Shape Annotation Object Chapter 10 Object Menu Frame Grabber & Image Editor

Shape Exclusion Object Chapter 10 Object Men Frame Grabber & Image Editor

Shape Temperature Object Chapter 10 Object Menu Frame Grabber & Image Editor

Shape Temperature (field) Field Chapter 14 Field Menu Report Editor

Show All Objects Image Chapter 7 Image Menu Image Editor & Frame Grabber

Show Border Format Chapter 15 Format Menu Report Editor

Show Graph Properties Chapter 10 Properties . . . Frame Grabber & Image Editor

Show Label Format Chapter 14 Format Menu Report Editor

Smooth Image Image Chapter 7 Image Menu FG, Image Editor

Slow Forward Replay Tool Bar Chapter 8  Special Tool Bars Replay viewer

Solid Color Image Chapter 7 Image Menu FG, Image Editor

Spline Graph Mode Chapter 18 Graph Mode Menu Graph Module

Spline w/Points Graph Mode Chapter 18 Graph Mode Menu Graph Module

Spot Temperature Object Chapter 10 Object Menu Frame Grabber & Image Editor

Spot Temperature (field) Field Chapter 14 Field Menu Report Editor

Stacked Area Graph Mode Chapter 18 Graph Mode Menu Graph Module

Stacked Bar Graph Mode Chapter 18 Graph Mode Menu Graph Module

Stop Replay Tool Bar Chapter 8  Special Tool Bars Replay Viewer

Table Settings Chapter 21 Customizing the 
Graph . . .

Graph Module

Function Menu 
Location Manual Location Software Location



Z

V

U

Temperature Adjust Object Chapter 9 Object Menu Frame Grabber & Image Editor

Text Properties Chapter 19 Properties . . . Frame Grabber & Image Editor

Text Annotation Object Chapter 9 Object Menu Frame Grabber & Image Editor

Text Annotation Object Chapter 18 Report Editor 
Object . . 

Report Editor

Text Color Format Chapter 15 Format Menu Report Editor

Tile Windows Chapter 11 Windows . . . All

Toolbars File Chapter 5 File Template, Report and Graph 
Modules

Transparent Format Chapter 14 Format Menu Report Editor

Transparent Properties Chapter 10 Properties Menu FG, Image Editor

Undo Edit Chapter 4 Edit Menu All

Units Field Chapter 15 Field Menu Report Editor

View Graph Report Chapter 13 Report Menu All

Visible Properties Chapter 13 Properties . . . Frame Grabber & Image Editor

Zoom in View Chapter 13 View Menu Frame Grabber & Image Editor

Zoom to Full Screen View Chapter 13 View Menu Frame Grabber & Image Editor

Zoom to Full Screen Graph Mode Chapter 18 Graph Mode Menu Graph Module

Function Menu 
Location Manual Location Software Location
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